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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
http://www.okiprintingsolutions.com

07110401 iss. 2; Copyright © 2010 Oki Europe Ltd. All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
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ABOUT THIS GUIDE

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you 
become familiar with your product and to make the best use of its many powerful features. 
The documentation is summarised below for reference and is found on the manuals DVD 
unless indicated otherwise:

> Installation Safety booklet: provides information for safe use of your product.

This is a paper document that is packaged with the product and should be read before 
setting up your machine.

> Set-up guide: describes how to unpack, connect and turn on your product.

This is a paper document that is packaged with the product.

> User’s Guide: helps you become familiar with your product and make the best use 
of its many features. Also included are guidelines for troubleshooting and 
maintenance to ensure that it performs at its best. Additionally, information is 
provided for adding optional accessories as your printing needs evolve.

> Configuration Guide: provides machine, fax and network configuration 
information.

> Printing Guide: helps you become familiar with the many features of the driver 
software supplied with your product.

> Barcode Printing Guide: helps you become familiar with your product’s built in 
barcode printing feature.

> Security Guide: helps you become familiar with your product’s security features.

> Installation Guides: accompany consumable items and optional accessories to 
describe how to install them.

These are paper documents that are packaged with the consumables and optional 
accessories.

> On-line Help: on-line information accessible from the printer driver and utility 
software.

PURPOSE OF THIS GUIDE

The purpose of this guide is to provide you with in-depth information on how configure the 
network, scan and fax for your machine.

NOTE
Images used in this manual may include optional features that your product 
does not have installed.
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ON-LINE USAGE

This guide is intended to be read on screen using Adobe Reader. Use the navigation and 
viewing tools provided in Adobe Reader.

There are many cross-references within this book, each highlighted as blue text. When you 
click on a cross-reference the display will instantly jump to the part of the manual 
containing the referenced material. 

By using the  button in Adobe Reader, you can navigate directly back to where you were 
before.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of 
interest to jump to the required topic. (If the bookmarks are not available, use the 
“Contents” on page 3.)

> In the list of bookmarks, click on Index to jump to the Index. (If the bookmarks are 
not available, use the “Contents” on page 3.) Find the term of interest in the 
alphabetically arranged index and click on the associated page number to jump to 
the page containing the term.

PRINTING PAGES

The whole manual, individual pages, or sections may be printed. The procedure is:

1. From the toolbar, select File > Print (or press the Ctrl + P keys).

2. Choose which pages you wish to print:

(a) All pages, (1), for the entire manual.

(b) Current page, (2), for the page at which you are looking.

(c) Pages from and to, (3), for the range of pages you specify by entering their 
page numbers.

(d) Click OK.

1 
2 
3 
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CONFIGURING THE NETWORK SETTINGS
Functions such as Scan To E-mail, Scan To Network PC and Internet Fax enable you to send 
scanned data to a computer via the network connection. To use them, you need to set up 
your machine and the computer to which you want to send scanned data.

First check your computer settings and fill in the information in the Your Value column of 
the “Setup Information Form,” on page 9. Then, configure your machine and the computer 
using the information in Your Value.

Table 1: Setup Information Form

NOTE
Be sure to set up the network connection before continuing. Refer to the Setup 
Guide supplied with the machine.

NO. ITEM EXAMPLE YOUR VALUE

Common Setup Information

A-1 Administrator password for your machine aaaaaa

A-2 IP address of your machine 192.168.0.2

Setup Information Required for Scan To Email and Internet Fax

B-1 Email address for your machine mc561@test.com

(Up to 80 characters)

B-2 SMTP server address smtp.test.com

B-3 POP3 server address pop3.test.com

B-4 Authentication method SMTP

B-5 SMTP user ID OKIMC561

B-6 SMTP password okimc561

B-7 POP user ID user

B-8 POP password okimc561

B-9 Name of the email destination User

B-10 Email address of the email destination user@test.com

Setup Information Required for Scan To Network PC

C-1 Name of the destination computer PC1

C-2 User name to log into the destination 
computer

mc561

(Up to 32 characters)

C-3 Password to log into the destination 
computer

mc561

(Up to 32 characters)

C-4 Profile name to register the settings Sales

(Up to 16 characters)

C-5 Shared folder name on the destination 
computer

SalesDev

(Up to 64 characters)

C-6 File name of the scanned data ScanData

(Up to 64 characters)
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CHECKING THE COMMON SETUP INFORMATION

Check the common setup information for Scan To E-mail, Scan To Network PC and Internet 
Fax, and fill in the corresponding column in the “Setup Information Form,” on page 9.

Administrator password

Enter the administrator password of your machine in the “Setup Information Form,” on 
page 9.

IP address of your machine

1. Press the SETTING key on the control panel.

2. Using the Down arrow key, scroll to View Information and press OK.

3. Using the Down arrow key, scroll to Network and press OK.

4. Note the IPv4 address in the “Setup Information Form,” on page 9.

SETTING UP SCAN TO E-MAIL AND INTERNET FAX

The Scan To E-mail and Internet Fax functions enable you to send scanned images as a file 
attachment in an e-mail to the specified e-mail address on the network. To use these 
functions, set up the e-mail setting for your machine.

CHECKING THE E-MAIL SETTINGS OF THE COMPUTER

If a network administrator specifies the values such as a mail server account, password and 
email address for your machine, note them in the “Setup Information Form,” on page 9, 
otherwise follow the procedure below.

1. Click Start > Windows Live Mail.

2. From the drop-down menu, select Tools > Accounts.

If the menu bar is not displayed, click the Menus icon and then select Show menu 
bar.

3. Select the default mail account and then click Properties.

NOTE
The default administrator password is “aaaaaa”.

Passwords are case sensitive.

NOTE
The procedure below uses Windows Live Mail on Windows 7. If you are using 
different email software, refer to the manual for the email software.
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4. On the General tab, note the Name and E-mail address in the “Setup Information 
Form,” on page 9.

5. Click the Server tab, and then note each of the settings as shown:

If My server requires authentication is selected, enter “SMTP”.

If it is not selected, enter “POP”.

6. Select My server requires authentication and then click Settings.

7. Refer to the Outgoing Mail Server dialog box, and note the settings in the “Setup 
Information Form,” on page 9.

If Use the same settings as my incoming mail server is selected, enter the same 
values as above.

If Log on using is selected, note the Account name and Password.

B-9

B-10

B-3

B-2

B-7

B-8

B-5

B-6
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SETTING THE E-MAIL ADDRESS FOR YOUR MACHINE

Enter an e-mail address to be used by your machine in the “Setup Information Form,” on 
page 9.

> If the e-mail address for your machine is specified by the network administrator, 
enter the email address in B-1.

> If you are using an Internet Service Provider, obtain an e-mail address for your 
machine from the provider and then enter the e-mail address in B-1.

> If the e-mail address for your machine is neither specified nor obtained, determine 
the e-mail address according to the value you entered in authentication method:

> If authentication method is “SMTP”, determine an e-mail address and enter it 
in B-1.

> If authentication method is “POP”, enter the same e-mail address as B-12 in 
B-1.

NOTE
If you want your machine to receive e-mail, you must obtain an e-mail 
address for your machine from a network administrator or your Internet 
Service Provider.
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CONFIGURING YOUR MACHINE FOR SCAN TO E-MAIL AND INTERNET FAX

Set up your machine for Scan To E-mail and Internet Fax using the information in the 
“Setup Information Form,” on page 9.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Easy Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to E-mail Setting and then press the Right 
arrow key.

5. Press the Right arrow key, then enter the SMTP server address (B-2) using the 
arrow keys and on-screen keypad.

6. Highlight Done and then press OK.

7. Press the Right arrow key, then enter the e-mail address for your machine (B-
1) using the arrow keys and on-screen keypad.

8. Highlight Done and then press OK.

9. Press the Right arrow key, then enter the authentication method (B-4) using the 
arrow keys and on-screen keypad.

10. Highlight Done and then press OK.

11. Press the Right arrow key, then enter the SMTP user ID (B-5) using the arrow 
keys and on-screen keypad.

12. Highlight Done and then press OK.

13. Press the Right arrow key, then enter the SMTP password (B-6) using the arrow 
keys and on-screen keypad.

14. Highlight Done and then press OK.

15. Press the Right arrow key, then enter the POP-3 server address (B-3) using the 
arrow keys and on-screen keypad.

16. Highlight Done and then press OK.

17. Press the Right arrow key, then enter the POP-3 user ID (B-7) using the arrow 
keys and on-screen keypad.

18. Highlight Done and then press OK.

19. Press the Right arrow key, then enter the POP password (B-8) using the arrow 
keys and on-screen keypad.

20. Highlight Done and then press OK.

21. When the setup menu screen is displayed, press OK.

The setup for Scan To E-mail and Internet Fax is complete.

NOTE
The default password is “aaaaaa”.
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SETTING UP SCAN TO NETWORK PC
The Scan To Network PC function enables you to send and save scanned images to the 
“shared folder” of a computer on the network. To use this function, register your machine 
on the computer as a user and create a shared folder, and then create a profile on your 
machine to register the settings for the computer.

CHECKING THE NAME OF THE COMPUTER

Check the name of the computer following the procedure below, and fill in C-1 of the “Setup 
Information Form,” on page 9.

Windows 7, Windows Server 2008 R2, Windows Server 2008 and Vista

1. Click Start > Control Panel.

2. Select System and Security.

For Windows Server 2008 and Windows Vista, select System and Maintenance.

3. Click System > See the name of this computer.

4. Note the Computer name in C-1.

5. Close the window.

NOTE
Before starting the setup, get permission from the network administrator to 
create a shared folder on the computer by following the procedure below.

The CIFS protocol is used in this procedure.

NOTE
The procedure below uses Windows 7 as an example. The display may differ 
depending on the operating system.

C-1
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Windows Server 2003 and Windows XP

1. For Windows Server 2003, click Start > Control Panel > System.

For Windows XP, click Start > Control Panel > Performance and Maintenance > 
System.

2. Select the Computer Name tab and then click Change.

3. Note the Computer name in C-1.

4. Click Cancel to close the window.

Windows 2000

1. Click Start > Settings > Control Panel.

2. Double-click System.

3. Select the Network Identification tab and then click Properties.

4. Note the Computer name in C-1.

5. Click Cancel to close the window.
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DETERMINING THE NAMES OF THE ITEMS REQUIRED FOR SCAN TO NETWORK PC

Determine the names of the following items and fill in C-2 to C-6 on the “Setup Information 
Form,” on page 9.

> User name to log into the destination computer (C-2)

> Password to log into the destination computer (C-3)

> Profile name to register the settings on your machine (C-4)

> Shared folder name on the destination computer (C-5)

> File name of the scanned data (C-6)

CONFIGURING THE COMPUTER FOR SCAN TO NETWORK PC

Register your machine on the computer as a user and then set up a shared folder to which 
scanned images are sent and saved.

Windows 7, Windows Server 2008 R2, Windows 2008 and Windows Vista

1. Click Start > Control Panel.

2. Select Add or remove user accounts.

3. Select Create a new account.

4. Enter the user name (C-2) in the text box.

5. Ensure that Standard user is selected, and then click Create Account.

6. Click the icon of the user account created in step 5.

NOTE
If the computer is in a domain, the procedure of adding a user account may 
be different to the procedure below.

Refer to Windows help.

NOTE
The procedure below uses Windows 7 as an example. The display may differ 
depending on the operating system.

C-2
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7. Select Create a password.

8. Enter the password (C-3) in New password and Confirm for new password, 
and then click Create password.

9. Close the control panel.

10. Create a new folder on the computer with the shared folder name entered in C-5.

11. Right-click the folder created in step 10 and select Properties.

12. Select the Sharing tab and then click Share.

NOTE
It is recommended that you create a folder in the local drive, not on the 
desktop or “My Documents”.

C-3
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13. Select the user account created in step 5 from the drop down box, then click Add.

14. Select the user added in step 13 and select the permission level, then click Share.

15. Click Done.

16. Click Advanced Sharing on the Sharing tab.

17. Click Permissions.
Configuring the network settings > 18



18. Select the user added in step 13 and select the Allow check box for Full Control, 
then click OK.

19. Close the folder’s property dialog box.

Windows Server 2003

1. Click Start > Administrative Tools > Server Management.

2. Click Users.

3. Select Add a user.

4. Enter the user name (C-2) in the First name text box and then click Next.

5. Enter the password (C-3) in Password and Confirm password.

6. Select the Cannot change password and then click Next.

7. Click Finish.

8. Click Close.

9. Create a new folder on the computer with the shared folder name entered in C-5.

10. Right-click the folder created in step 9, and then select Sharing and Security.

11. On the Sharing tab, select Share this folder and then click Permissions.

12. Click Add.

13. Enter the user name (C-2) and then click Check Names.

14. Check that the user name (C-2) is displayed, and then click OK.

15. Select the Allow check box for Full Control, and then click OK.

NOTE
Create a profile to complete the setup for Scan To Network PC. Refer to 
“Creating a profile for scan to network PC” on page 22.

NOTE
It is recommended that you create a folder in the local drive, not on the 
desktop or “My Documents”.
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16. Close the folder’s property dialog box.

Windows XP

1. Click Start > Control Panel.

2. Double-click User Accounts.

3. Select Create a new account.

4. Enter the user name (C-2) in the text box and click Next.

5. Select Limited and click Create Account.

6. Click the icon of the user account created in step 5.

7. Select Create a password.

8. Enter the password (C-3) in Type a new password and Type the new 
password again to confirm, and then click Create Password.

9. Close the control panel.

10. Create a new folder on the computer with the shared folder name entered in C-5.

11. Right-click the folder created in step 10, and then select Sharing and Security.

12. Click If you understand the security risks but want to share files without 
running the wizard, click here..

13. Select Share this folder in Windows Firewall, and then click OK.

14. Select the Share this folder on the network and Allow network users to 
change my files check box, and then click OK.

15. Select the Allow check box for Full Control, and then click OK.

NOTE
Create a profile to complete the setup for Scan To Network PC. Refer to 
“Creating a profile for scan to network PC” on page 22.

NOTE
It is recommended that you create a folder in the local drive, not on the 
desktop or “My Documents”.

NOTE
If a pop-up screen displays, select Share this folder and click Permissions. 
Proceed to step 15.

NOTE
Create a profile to complete the setup for Scan To Network PC. Refer to 
“Creating a profile for scan to network PC” on page 22.
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Windows 2000

1. Right-click My Computer on the desktop and then select Manage.

2. In the right window, double-click System Tools > Local Users and Groups, and 
then Right-click Users and select New User.

3. Enter the user name (C-2) in User name and the password (C-3) in Password 
and Confirm Password.

4. Select User can not change password and Password never expires, and then 
click Create.

Click Close to close the New User dialog.

5. Double-click User and check that the user created in step 4 is displayed.

Close the Computer Management window.

6. Create a new folder on the computer with the shared folder name entered in C-5.

7. Right-click the folder created in step 6 and then select Sharing.

8. Select Share this folder and then click Permissions.

9. Click Add.

10. Select the user account created in step 4 and then click Add.

11. Check that the user account is displayed, and then click OK.

12. Select the Allow check box for Full Control, and then click OK.

13. Ensure that the icon of the shared folder changes into the icon with a hand, and then 
close the window.

NOTE
If User must change password at next logon is selected, clear it so that 
you can select User can not change password and Password never 
expires.

NOTE
It is recommended that you create a folder in the local drive, not on the 
desktop or “My Documents”.

NOTE
Create a profile to complete the setup for Scan To Network PC. Refer to 
“Creating a profile for scan to network PC” on page 22.
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MANAGING PROFILES

CREATING A PROFILE FOR SCAN TO NETWORK PC

Register the information you configured on the computer as a profile. It is necessary when 
you perform Scan To Network PC with the computer.

1. Press the SETTING button on the control panel to prompt the Setting screen.

2. Using the Down arrow key, scroll to Profile and press OK.

3. Select the desired profile number.

4. Press the Right arrow key to prompt the Operation Menu screen.

From here you can register or sort profiles.

5. When registering a new profile, press the Right arrow key to prompt the Profile 
screen.

6. Ensure Profile Name: is highlighted then press the Right arrow key.

7. Using the arrow keys and on-screen keypad, enter the information in C-4.

8. Using the arrow keys, highlight Done and press OK.

9. Using the Down arrow key, scroll to Target URL then press the Right arrow key.

10. Using the arrow keys and on-screen keypad, enter the name of the destination 
computer (C-1) and the shared folder name (C-5) as “\\name of the 
destination computer\shared folder name”.

11. Using the arrow keys, highlight Done and press OK.

12. Using the Down arrow key, scroll to User Name then press the Right arrow key.

13. Using the arrow keys and on-screen keypad, enter a suitable user name (C-2).

14. Using the arrow keys, highlight Done and press OK.

15. Using the Down arrow key, scroll to Password then press the Right arrow key.

16. Using the arrow keys and on-screen keypad, enter a suitable password (C-3).

17. Using the arrow keys, highlight Done and press OK.

18. Using the Down arrow key, scroll to File Name then press the Right arrow key.

19. Using the arrow keys and on-screen keypad, enter a suitable file name (C-6).

20. Using the arrow keys, highlight Done and press OK.

21. Configure other items if necessary, for example:
\\PC1\SalesDev

NOTE
MC561 only: You can also use the qwerty keyboard to enter details.

NOTE
If domain management is done, enter “user name@domain name”.

NOTE
You can enter up to 64 characters.

By adding “#n” to the end of the file name, a serial number is automatically 
assigned to the end of the name of sent files.

By adding “#d” to the end of the file name, a date is automatically assigned 
to the end of the name of sent files.
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22. Press OK to register the settings and save the profile entry.

The setup for Scan To Network PC is complete.

DELETING A NETWORK PROFILE

To delete a network profile:

1. Press the SETTING button on the control panel to prompt the Setting screen.

2. Using the Down arrow key, scroll to Profile List and press OK.

3. Select the desired profile number.

4. Ensure Delete is highlighted then press the Right arrow key.

5. At the prompt:

> press OK to continue deleting the profile entry,

or...

> use the Right arrow key to highlight No, then press OK to cancel.
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MANAGING THE ADDRESS BOOK

SETTING SENDER AND REPLY TO E-MAIL ADDRESSES (FROM/REPLY TO)

You can set the e-mail address from which e-mails are sent and the address to which 
responses are sent.

1. Press the SETTING button.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keyboard, enter the administrator password.

4. Select Done and then press OK.

5. Using the Down arrow key, scroll to Scanner Setup and then press OK.

6. Using the Down arrow key, scroll to E-mail Setup and then press OK.

7. Using the Down arrow key, scroll to From/Reply to and then press OK.

8. Using the Down arrow key, scroll to From or Reply to and then press OK.

9. Using the on-screen keyboard, enter the e-mail address up to 80 characters.

10. Select Done and then press OK.

11. Using the Down arrow key, scroll to Close and then press OK.

12. Press the RESET/LOGOUT button.

NOTE
The default password is “aaaaaa”.

MC561 only: You can also use the qwerty keyboard to enter details.

NOTE
MC561 only: You can also use the qwerty keyboard to enter details.

NOTE
You can select e-mail addresses from the address book.
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CREATING E-MAIL TEMPLATES

You can create up to five e-mail templates with various subject lines and body text.

Registering a subject

1. Press the SETTING button.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keyboard, enter the administrator password.

4. Select Done and then press OK.

5. Using the Down arrow key, scroll to Scanner Setup and then press OK.

6. Using the Down arrow key, scroll to E-mail Setup and then press OK.

7. Using the Down arrow key, scroll to Template and then press OK.

8. Make sure that Edit Subject is selected and then press OK.

9. Using the Down arrow key, select a template entry number and then press OK.

10. Using the on-screen keyboard, enter the subject up to 80 characters.

11. Select Done and then press OK.

Registering body text

1. Follow steps 1 to 7 in “Registering a subject” on page 25.

2. Using the Down arrow key, scroll to Edit Body and then press OK.

3. Using the on-screen keyboard, enter the body text up to 256 characters.

4. Select Done and then press OK.

NOTE
The default password is “aaaaaa”.

MC561 only: You can also use the qwerty keyboard to enter details.

NOTE
MC561 only: You can also use the qwerty keyboard to enter details.

NOTE
MC561 only: You can also use the qwerty keyboard to enter details.
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ADDING AN E-MAIL ADDRESS ENTRY TO THE ADDRESS BOOK

The machine can hold up to 100 e-mail addresses in the address book. To assign a new 
e-mail address to the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to E-mail Address and press the Right arrow 
key.

10. Using the keypad or arrows keys and the on-screen keypad, type in the new e-mail 
address.

11. Highlight Done and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow 
key.

13. Using the arrow keys, select the group number to assign the e-mail address to and 
press OK.

The check box is selected. You can select multiple entries.

14. Press the Right arrow key to complete.

15. Press OK to confirm.

16. Press OK once more to add your entry to the address book.

17. Press the Left arrow key to exit the menu.

DELETING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete an e-mail address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

NOTE
The maximum length of name is 16 characters.

If you do not enter a name, this column remains blank.

NOTE
The maximum length of address is 80 characters.
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8. Press the Left arrow key to exit the menu.

MODIFYING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit an e-mail address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, E-mail Address and/or Group No. details as required then press 
OK.

7. Press the Left arrow key to exit the menu.

ADDING A GROUP ENTRY TO THE ADDRESS BOOK

The machine can hold up to 20 group addresses. To add a new group address to the address 
book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to Address No. and press the Right arrow key.

10. Using the arrow keys, select the destination to assign the e-mail group to and press 
OK.

The check box is selected. You can select multiple entries.

11. Press the Right arrow key to complete.

12. Press OK to confirm.

13. Press OK once more to add your entry to the address book.

14. Press the Left arrow key to exit the menu.

NOTE
The maximum length of name is 16 characters.
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DELETING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete a group address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

MODIFYING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit a group address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name and/or Address No. details as required then press OK.

7. Press the Left arrow key to exit the menu.
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CONFIGURING THE FAX SETTINGS (MC361 AND MC561)

BASIC SETUP

Minimum configuration requirements; a PSTN telephone line connection.

If you wish to connect an external telephone or answering machine, refer to “Adding a 
telephone handset” on page 32.

Your MFP has to be set up properly to allow faxing from the machine. The following 
parameters must be set before using the fax function:

> Date and time

> Local fax number

> Sender ID

There are other parameters that can be adjusted to suit your personal preferences later if 
required, refer to fax set up table for details (See “Advanced set up” on page 30).

To set fax parameters:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Easy Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Press the Right arrow key to select Date/Time Setting.

5. Using the arrow keys, select the correct time zone and press OK.

6. Using the arrow keys, select the correct daylight saving option and press OK.

7. Press OK to select Manual.

8. Using the arrow keys, enter today’s date.

9. Press OK.

10. Using the arrow keys, enter the correct time.

11. Press OK.

12. Using the Down arrow key and scroll to Fax Setting then press Right arrow key.

13. Press the Right arrow key to select Fax Number.

14. Using the keypad and on screen options enter the fax number for this MFP.

15. Highlight Done and press OK.

NOTE
If you ran the Oki driver installer program from the DVD-ROM you may have 
already set the time zone, date and time via the Panel Language Setup utility.

NOTE
The default password is “aaaaaa”.

NOTE
Use the Right and Left arrow keys to move between digits.

NOTE
Use the Right and Left arrow keys to move between digits.
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16. Press the Right arrow key to select Sender ID.

17. Using the keypad or arrow keys and on screen keyboard, enter the sender ID.

18. Highlight Done and press OK.

19. Press OK to complete.

20. Press the Left arrow key to exit the menu.

ADVANCED SET UP

Your machine offers a multitude of features which reduce the time required for manual 
operation and make fax communications more efficient.

CONNECTING TO A PBX

Private branch exchanges (PBXs) are private telephone systems used to route calls 
internally, for example, in a company. When dialling a telephone number, if a prefix is 
required to open an outside line, the line is connected to a PBX. If this MFP is going to be 
connected to a PBX, please make the following changes to enable it to recognise the prefix 
digits in the telephone numbers used to obtain access to the outside line. After dialling the 
prefix digits, the MFP will wait until the outside line is available (secondary dial tone 
detected) before dialling the rest of the number.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Fax Setup and press OK.

5. Using the Down arrow key, scroll to Other Settings and press OK.

6. Using the Down arrow key, scroll to Prefix and press OK.

7. Using the keypad, arrow keys and on screen options, enter the required prefix and 
press OK.

8. Press the Left arrow key to exit the menu.

NOTE
Maximum 22 characters.

NOTE
By default the country code is set to International. If you need to change this, 
refer to “Country Code” on page 101.

If required, set the dialling method for your region (Pulse or Tone). Refer to 
“MF(Tone)/DP(Pulse)” on page 117.

If connecting the machine through a private branch exchange (PBX) line, you 
must also specify a dial prefix to allow the machine to obtain an external line 
before dialling. Refer to “Connecting to a PBX” on page 30.
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AUTOMATIC REDIAL

You can set the fax to automatically redial if the initial fax transmission fails. The machine 
will redial on:

> Line busy

> No answer

> Communication error

To set auto-redial:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Fax Setup and press OK.

5. Using the Down arrow key, scroll to Other Settings and press OK.

6. Press OK to select the Redial Tries.

7. Using the keypad, enter the required number of redial attempts (between 0 and 9), 
then press OK to confirm.

8. Using the Down arrow key, scroll to Redial Interval and press OK.

9. Using the keypad, enter the required redial interval (between 1 and 5 minutes), then 
press OK to confirm.

10. Press the Left arrow key to exit the menu.

RECEPTION MODE

You can change the way your MFP handles incoming fax transmissions and telephone calls 
(if you have a telephone handset connected) depending on your office requirements.

Choose from:

> Fax Ready Mode

> Tel/Fax Ready Mode

> Ans/Fax Ready Mode

> Tel Ready Mode

> DRD

To change the reception mode:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to User Install and press OK.

5. Using the Down arrow key, scroll to Reception Mode and press OK.

6. Using the arrow keys, select the required reception mode and press OK.

7. Press the Left arrow key to exit the menu.

The machine behaviour differs depending on the specified reception mode, refer to the 
User’s Guide for details.
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ADDING A TELEPHONE HANDSET

If you want to add a telephone handset to your MFP, connect the line to the Tel socket (in 
certain countries it may be necessary to use a telephone plug adaptor).

You will also need to update the telephone settings to set the ring response:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Fax Setup and press OK.

5. Using the Down arrow key, scroll to Other Settings and press OK.

6. Using the Down arrow key, scroll to Ring Response and press OK.

7. Using the arrow keys, select the required response setting (between 1 ring and 20 
seconds) and press OK.

8. Press the Left arrow key to exit the menu.

NOTE
You must also set the reception mode to the appropriate setting. See 
“Reception mode” on page 31.

NOTE
Dialling for speech purposes is not available using the MFP keypad or speed 
dial keys.
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MANAGING THE PHONE BOOK

The following section describes how to add/remove/modify speed and group dial entries to/
from the Phone Book.

ADDING A SPEED DIAL ENTRY TO THE PHONE BOOK

The machine can hold up to 100 speed dial numbers in the phone book. To add a new speed 
dial number to the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial List.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to Fax Number and press the Right arrow key.

10. Using the keypad, type in the destination fax number.

11. Highlight Done and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow 
key.

13. Using the arrow keys, select the group number to assign the fax number to and 
press OK.

The check box is selected. You can select multiple entries.

14. Press the Right arrow key to complete.

15. Press OK to confirm.

16. Press OK once more to add your entry to the phone book.

NOTE
The maximum length of name is 24 characters.

NOTE
The maximum length of number is 40 digits.

If the destination fax number has an “extension number”, press the Pause 
button between numbers. The machine will enter a pause when dialling.

If your MFP is connected to a PBX (private branch exchange), you will need to 
add a Prefix in order to access to the outside line. Refer to “Connecting to a 
PBX” on page 30.

If you need to change the dialling method for the region, press the Tone 
button to change the call parameters for this particular number.

If you make a mistake while entering the number, press the Clear button to 
delete the last digit.

NOTE
Numbers registered to groups from the Speed Dial function are synchronized 
with the numbers that are registered to groups using the Group No. function.
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17. Press the Left arrow key to exit the menu.

ADDING A GROUP ENTRY TO THE PHONE BOOK

The machine can hold up to 20 group dial settings. To add a new group dial number to the 
phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. Book and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to Speed Dial and press the Right arrow key.

10. Using the arrow keys, select the speed dial number you wish to assign to the group 
and press OK.

The check box is selected. You can select multiple entries.

11. Press the Right arrow key to complete.

12. Press OK to confirm.

13. Press OK once more to add your entry to the phone book.

14. Press the Left arrow key to exit the menu.

DELETING A SPEED DIAL ENTRY FROM THE PHONE BOOK

To delete a speed dial entry from the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial List.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

DELETING A GROUP DIAL ENTRY FROM THE PHONE BOOK

To delete a group dial entry from the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. Book and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

NOTE
The maximum length of name is 16 characters.
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5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

MODIFYING A SPEED DIAL ENTRY

To modify a speed dial entry:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial List.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, Fax Number and/or Group No. details as required then press OK.

7. Press the Left arrow key to exit the menu.

MODIFYING A GROUP DIAL ENTRY

To modify a group dial entry:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. Book and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, and/or Speed Dial details as required then press OK.

7. Press the Left arrow key to exit the menu.

REGISTERING AN ENTRY FROM RECEPTION OR TRANSMISSION HISTORY

1. Press the Fax button on the control panel to prompt the Fax Mode screen.

2. Ensure Fax is highlighted, then press OK.

3. Using the Down arrow key, scroll to Fax History and press OK.

4. Using the arrow keys, highlight Tx History or Rx History as appropriate and press 
OK.

5. Using the arrow keys, scroll to the required entry and press OK.

6. Check the entry contents and then press the Right arrow key.

7. Press OK to select Register To Speed Dial.

8. Using the arrow keys, scroll to the required entry position and press OK.

9. Continue the registration process as described in “Adding a speed dial entry to the 
phone book” on page 33.

The fax number is automatically entered. You do not have to enter it manually.
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USER AUTHENTICATION AND ACCESS CONTROL
The user authentication and access control functions allow you to limit the functions 
available to each user. These functions can help you save toner and paper.

Your machine has the following two methods of user authentication:

> PIN (personal identification number)

> User name and password

To control access to the machine, register a PIN or a user name and password for each user 
in advance. The user must enter the PIN (or the user name and password) to log into the 
machine or to print from a computer.

Access control can be applied to the following functions:

> Copying (Color/Mono)

> Printing (Color/Mono)

> Printing from USB Memory

> Scanning to e-mail

> Scanning to network PC

> Scanning to USB memory

> Faxing (MC361 and MC561 only)

> Faxing via PC (MC361 and MC561 only)

> Internet Faxing (MC361 and MC561 only)

The following conditions are required to enable the user authentication and access control 
functions:

> Your machine is connected to a network

> A computer on which Configuration Tool is installed is on the network

NOTE
You can register up to 100 PINs and 100 user name and password sets.
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PIN AUTHENTICATION

REGISTERING A PIN

Before enabling user authentication and access control, be sure to register a PIN for each 
user. You must be the administrator to register PINs. 

To register a PIN, launch PIN Manager from Configuration Tool.

ENABLING PIN AUTHENTICATION

You must be the logged on as the administrator to control access to the machine.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Management and press OK.

5. Using the Down arrow key, scroll to System Setup and press OK.

6. Make sure that Access Control is selected and press OK.

7. Using the arrow keys, scroll to PIN and press OK.

8. Press the BACK button to exit the menu.

NOTE
You can also register a PIN from the MFP web page.
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OPERATION WHEN PIN AUTHENTICATION IS ENABLED

Logging into the machine

For general users

1. Enter your PIN using the keypad on the control panel.

2. Press OK.

If authentication succeeds, the top screen displays.

For the Administrator

1. Enter “000000” using the keypad on the control panel.

2. Press OK.

3. When the password entry screen displays, enter the administrator password.

4. Using the arrow keys, highlight Done and then press OK.

If authentication succeeds, the top screen displays.

Logging out of the machine

When you have finished operations, be sure to log out of the machine.

1. Press the BACK button or Left arrow key until the top screen displays.

2. Press the RESET/LOGOUT button on the control panel.

NOTE
The Administrator PIN is “000000”. You cannot change this value.

NOTE
After a certain period of time, the machine automatically logs out users.
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USER NAME AND PASSWORD AUTHENTICATION

REGISTERING A USER NAME AND PASSWORD

Before enabling user authentication and access control, be sure to register a user name and 
a password for each user. You must be the administrator to register user names and 
passwords.

To register a user name and password, launch PIN Manager from Configuration Tool.

ENABLING USER NAME AND PASSWORD AUTHENTICATION

You must be the logged on as the administrator to control access to the machine.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Management and press OK.

5. Using the Down arrow key, scroll to System Setup and press OK.

6. Make sure that Access Control is selected and press OK.

7. Using the arrow keys, scroll to User/Password and press OK.

8. Using the Down arrow key, scroll to User Authentication Method and press OK.

9. Make sure that Local is selected and press OK.

10. Press the BACK button to exit the menu.

OPERATION WHEN USER NAME AND PASSWORD AUTHENTICATION IS ENABLED

Logging into the machine

1. Make sure that User Name is selected and then press the Right arrow key.

2. Enter your name.

3. Using the arrow keys, highlight Done and then press OK.

4. Make sure that Password is selected and then press OK.

5. Enter your password.

6. Using the arrow keys, highlight Done and then press OK.

7. At the Login screen, press OK.

If authentication succeeds, the top screen displays.

NOTE
You can also register a user name and password from the MFP web page.

NOTE
The default password is “aaaaaa”.

NOTE
When you select LDAP or Secure Protocol, the server settings are 
necessary. For details, refer to “Network Menu” on page 112.
User authentication and access control > 39



Logging out of the machine

When you have finished operations, be sure to log out of the machine.

1. Press the BACK button or Left arrow key until the top screen displays.

2. Press the RESET/LOGOUT button on the control panel.

OPERATION FROM THE COMPUTER

Printing from Windows

1. Open the file you want to print.

2. From the File menu, select Print.

3. Choose the printer driver you want in Select Printer and click Preferences.

4. Select the Job Options tab.

5. Click User Auth.

6. Select Enable User Authentication.

7. Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.

8. Click OK.

9. Click OK and then click Print.

Printing from Mac

1. Open the file you want to print.

2. From the File menu, select Print.

3. Select your machine’s printer driver.

4. Select User Authentication from the panel menu under the Printer and Presets 
menus.

5. Select Enable User Authentication.

6. Enter the user name in User Name and the password in Password.

7. Click Print.

NOTE
After a certain period of time, the machine automatically logs out users.

NOTE
The authentication type specified on the computer overrides the one specified 
on the machine.

NOTE
You cannot use the PCL XPS printer driver for this function.

This procedure uses Windows 7 and NotePad as an example. The procedures 
and menus may differ depending on the OS you use.

NOTE
This procedure uses Mac OS X 10.6 as an example. The procedures and menus 
may differ depending on the OS you use.
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Faxing (Windows only))

1. Open the file you want to fax.

2. From the File menu, select Print.

3. Select your machine (fax driver) in Select Printer and click Preferences.

4. On the Setup tab, click User Auth.

5. Select Enable User Authentication.

6. Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.

7. Click OK.

8. Click OK and then click Print.

NOTE
This procedure uses Windows 7 and NotePad as an example. The procedures 
and menus may differ depending on the OS you use.
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ADVANCED NETWORK SETTINGS
This chapter explains advanced network settings for your machine.

NETWORK SETTING ITEMS

This section explains the menus available for network settings.

You can check the current network settings by pressing the SETTING key and selecting 
View Information then Network on the machine control panel. You can also print the 
setting list.

You can change the network settings from the machine’s web page, Configuration Tool, 
TELNET, and Network Card Setup. For available menus on each utility, refer to the following 
tables.

TCP/IP

NOTE
For details on how to print the network setting list, refer to “Network 
Information” on page 87.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

IP 
Address 
Set

IP 
Address 
Set

DHCP/
BOOTP

DHCP/
BOOTP

DHCP/
BOOTP

Manual Specifies whether to 
request the DHCP/BOOTP 
server to assign an IP 
address.

IP 
Address

IP 
Address

IP Address IP 
Address

IP Address xxx.xxx.xxx.x
xx

Sets an IP address.

Subnet 
Mask

Subnet 
Mask

Subnet Mask Subnet 
Mask

Subnet 
Mask

xxx.xxx.xxx.x
xx

Sets a subnet mask.

Gateway 
Address

Gateway 
Address

Default 
Gateway 
Address

Default 
Gateway 
Address

Default 
Gateway 
Address

0.0.0.0 Sets a gateway address.

DNS 
Server 
(Primary)

DNS 
Server 
(Pri.)

- - - 0.0.0.0 Specifies the IP address of 
the primary DNS server.

Be sure to specify this item 
when you use a domain 
name to specify the SMTP/
POP/LDAP server.

DNS 
Server 
(Second-
ary)

DNS 
Server 
(Sec.)

- - - 0.0.0.0 Specifies the IP address of 
the secondary DNS server.

Be sure to specify this item 
when you use a domain 
name to specify the SMTP/
POP/LDAP server.

Dynamic 
DNS

Dynamic 
DNS

- - - Disable Specifies whether to 
register the information to 
the DNS server when a 
setting has been changed.
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Domain 
Name

Domain 
Name

- - - (NULL) Sets the domain name the 
machine belongs to.

WINS 
Server 
(Primary)

WINS 
Server 
(Pri.)

- - - 0.0.0.0 Specifies the name or IP 
address of the WINS server 
(for Windows only).

WINS 
Server 
(Second-
ary)

WINS 
Server 
(Sec.)

- - - 0.0.0.0 Specifies the name or IP 
address of the WINS server 
(for Windows only).

Scope ID Scope ID - - - (NULL) Specifies the Scope ID for 
WINS. From 1 to 223 
characters can be used.

Windows Windows - - - Disable Specifies whether to use 
the auto-discovery function 
of Windows.

Macintosh Macintosh - - - Enable Specifies whether to use 
the auto-discovery function 
of Macintosh.

Device 
Name

Printer 
Name

- - - OKI-(machine 
name)-(last 6 
digits of MAC 
address)

Specifies the rule of 
displaying the machine 
name when the auto-detect 
function is enabled.

IPv6 IP Version - - - Disable Specifies whether to use 
IPv6.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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NETWARE

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Print mode - - - - Print Server Specifies how to use the 
machine, as a print 
server, or as a remote 
printer.

Connection 
method

NetWare 
Mode

- - - NDS+
Bindery

Specifies the NetWare 
priority mode.

Communi-
cation 
protocol

TCP or IPX - - - IPX Select IPX or TCP/IP to be 
used on NetWare.

Print 
Server 
Name

Print Server 
Name

- - - OKI-
(machine 
name)-(last 
6 digits of 
Ethernet 
address)-PS

Specifies the print server 
name up to 31 
characters. This value 
must be identical to the 
one specified in the file 
server.

Printer 
Name

PrinterName - - - OKI-
(machine 
name)-(last 
6 digits of 
Ethernet 
address)-PR

Specifies the machine 
name when you use a 
remote printer. This value 
must be identical to the 
one specified in the file 
server.

Frame 
Type

Frame Type - - - Auto Specifies the frame type 
the machine uses on 
Netware.

Bindery 
Mode

- - - - Enable Specifies whether to use 
the bindery mode.

When you access Netware 
3.12 or the bindery 
network of NetWare 6.0, 
5.0, or 4.1, enable the 
bindery mode.

When you access NDS of 
NetWare 6.0, 5.0, or 4.1, 
disable the bindery mode.

File Server 
Names

File Server 
Name 
#1-8

- - - (NULL) Specifies the name of the 
file server up to 47 
characters. You can 
specify up to 8 servers.

Password 
for File 
Servers

Password - - - (NULL) Sets a password to log in 
to the file server up to 31 
characters.

You must specify this 
item when you set a 
password on the file 
server for the machine.

Job Polling 
Rate

JobPolling 
Time (Sec.)

- - - 4 (seconds) Sets the interval to 
access the queue for a 
print job.
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ETHERTALK

Tree NDS Tree - - - (NULL) Specifies the NDS tree 
name up to 31 
characters. Specify the 
tree name to which the 
file server belongs.

Context NDS Context - - - (NULL) Specifies the NDS context 
name up to 77 
characters. Specify the 
context name to which 
the print server belongs.

Job 
Timeout

Job Timeout 
(Sec.)

- - - 10 
(seconds)

Specifies when to free a 
port after the last print 
job has been accepted.

Print 
Server 
Names

Print Sever 
Name 
#1-8

- - - (NULL) Specifies the name of the 
print server to access up 
to 47 characters. You can 
specify up to 8 servers.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

EtherTalk 
Zone 
Name

Zone 
Name

- - - * Specifies the EtherTalk zone 
name up to 32 characters.

EtherTalk 
Printer 
Name

Printer 
Name

- - - (machine 
name)

Specifies the Ethertalk printer 
name up to 31 characters.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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NBT/NETBEUI

E-MAIL SEND

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Short 
Device 
Name

Short 
Device 
Name

- - - (machine 
name)-
(last 6 
digits of 
Ethernet 
address)

Sets the rule of specifying 
the name to be identified on 
NetBIOS over TCP/NetBEUI 
up to 15 characters. 

It is displayed on the 
PrintServer group in 
Network Computer on 
Windows.

Workgroup 
Name

Work 
group 
Name

- - - PrintServer Specifies the work group 
name to be displayed on 
Windows network 
computers up to 15 
characters. 

Master 
Browser 
Setting

Master 
Browser 
Setting

- - - Enable Specifies whether to use 
master browser.

Comment Comment - - - Ethernet-
Board 
OkiLAN 
8500e

Sets a comment up to 48 
characters. 

It is displayed when 
Windows Explorer is in the 
detailed view.

ITEM DEFAUL
T VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

SMTP Send SMTP 
Send

- - - Enable Specifies whether to use SMTP 
(E-mail).

SMTP 
Server

SMTP 
Server 
Name

- - - (NULL) Specifies the SMTP server 
name. Specify the domain 
name or IP address.

Be sure to configure DNS 
settings when you enter a 
domain name.

Device 
E-mail 
Address

Device 
Email 
Address

- - - (NULL) Specifies the e-mail address of 
the machine.

Authenticat
ion Method

SMTP 
Auth-
Method

- - - None Specifies whether to perform 
SMTP authentication.
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SMTP Port 
Number

SMTP Port 
Number

- - - 25 Specifies the SMTP port 
number.

SMTP 
UserID

SMTP 
Server 
User ID

- - - (NULL) Sets a user ID for SMTP 
authentication method.

SMTP 
Password

SMTP 
Server 
Password

- - - (NULL) Sets a password for SMTP 
authentication.

SMTP 
Encryption

SMTP 
Encryption 
Algorithm

- - - None Specifies the method for 
encrypting the SMTP (E-mail) 
send protocol.

POP UserID POP3 
Server 
UserID

- - - (NULL) Sets a user ID to access the 
POP server.

POP 
Password

POP3 
Server 
Password

- - - (NULL) Sets a password to access the 
POP server.

POP 
Encryption 
Algorithm

POP 
Encryption 
Algorithm

- - - None Specifies the method to 
encrypt POP communication.

Attached 
Information 
Device 
Model

Attached 
Info 
Device 
Model

- - - Enable Specifies whether to list the 
machine model name on an 
alert e-mail.

Attached 
Information 
Network 
Interface

Attached 
Info 
Network 
Interface

- - - Enable Specifies whether to list the 
network interface name on an 
alert e-mail.

Attached 
Information 
Serial 
Number

Attached 
Info Serial 
Number

- - - Enable Specifies whether to list the 
machine serial number on an 
alert e-mail.

Attached 
Information 
Asset 
Number

Attached 
Info Asset 
Number

- - - Disable Specifies whether to list the 
machine asset number on an 
alert e-mail.

Attached 
Information 
Device 
Name

Attached 
Info 
Device 
Name

- - - Disable Specifies whether to list the 
machine SystemName on an 
alert e-mail.

Attached 
Information 
Location

Attached 
Info 
Location

- - - Disable Specifies whether to list the 
machine SystemLocation on an 
alert e-mail.

Attached 
Information 
IP Address

Attached 
Info IP 
Address

- - - Enable Specifies whether to list the 
machine IP address on an alert 
e-mail.

ITEM DEFAUL
T VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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E-MAIL RECEIVE

Attached 
Information 
MAC 
Address

Attached 
Info MAC 
Address

- - - Disable Specifies whether to list the 
machine MAC address on an 
alert e-mail.

Attached 
Information 
Short 
Device 
Name

Attached 
Info Short 
Device 
Name

- - - Disable Specifies whether to list the 
short product name of the 
machine on an alert e-mail.

Attached 
Information 
Device URL

Attached 
Info 
Device 
URL

- - - Disable Specifies whether to list the 
machine URL on an alert e-
mail.

Comment Comment 
Line 1-4

- - - (NULL) Sets a comment to add to an 
alert e-mail. You can enter a 
maximum of 63 characters in a 
line. Up to 4 lines can be 
specified.

Reply-To-
Address

Reply-To 
Address

- - - (NULL) Specifies the e-mail address 
used to reply to e-mails. 
Specify the e-mail address of 
the network administrator.

ITEM DEFAUL
T VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Use 
Protocol

POP or 
SMTP

- - - Disable Specifies whether to use e-mail 
reception function. Select the 
protocol to use.

POP 
Server 
Name

POP3 
Server

- - - 0.0.0.0 Specifies the POP server name. 
Enter the domain name or IP 
address.

POP User 
ID

POP3 
Server 
UserID

- - - (NULL) Sets a user ID to access the 
POP server.

POP 
Password

POP3 
Server 
Password

- - - (NULL) Sets a password to access the 
POP server.

APOP 
Support

Use APOP - - - Disable Specifies whether to use APOP.

POP Port 
Number

POP port 
number

- - - 110 Specifies the port number to 
access the POP server.

ITEM DEFAUL
T VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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I
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W
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E
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C
W

C
W

E-MAIL ALERT

POP 
Encryption

POP 
Encryption 
Algorithm

- - - None Specifies the method to encrypt 
POP communication.

POP 
Receive 
Interval

MailPolling 
Time (min)

- - - 5 (mins) Specifies the interval to access 
the POP server to receive e-
mails.

Domain 
Filter

Domain 
filter

- - - Disable Specifies whether to use 
domain filtering.

Email from 
the 
following 
listed 
domains

Filter 
Policy

- - - Accept Specifies whether to accept or 
block e-mails from the specified 
domain.

Domain 
1-5

Domain 
1-5

- - - (NULL) Specifies a domain to apply 
domain filtering.

SMTP 
Receive 
Port 
Number

Port 
Number

- - - 25 Specifies the port number to 
access the machine via SMTP.

TEM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

ddress 1-5 Email 
Address 1-5

- - - (NULL) Specifies the destination e-
mail addresses. You can 
specify up to 5 destinations.

ay of E-
ail 
lerting

Notify Mode 
1-5

- - - Upon 
occurrence 
of an event

Specifies when to notify you 
of an error.

-mail Alert 
nterval

Email Alert 
Interval 
(Hours) 1-5

- - - 24 (Hours) Specifies the interval of the e-
mail alert. Valid only when the 
periodical alert is specified.

onsumable 
arning

Consumable 
Warning 
Event 1-5

- - - Immediate Specifies whether to notify 
you of a warning on 
consumables. Valid only when 
the alert in the event of an 
error is selected.

onsumable 
arning

Consumable 
Warning 
Period 1-5

- - - Enable Specifies whether to notify 
you of a warning on 
consumables. Valid only when 
the periodical alert is 
selected.

ITEM DEFAUL
T VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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M
a
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P
S
W

P
S
W

P
S
E

P
S
E

P
P
W

I

W
P

onsumable 
rror

Consumable 
Error Event 
1-5

- - - Immediate Specifies whether to notify 
you of an error on 
consumables. Valid only when 
the alert in the event of an 
error is selected.

onsumable 
rror

Consumable 
Error Period 
1-5

- - - Enable Specifies whether to notify 
you of an error on 
consumables. Valid only when 
the periodical alert is 
selected.

ainten-
nce Unit 
arning

Mainten-
ance Unit 
Warning 
Event 1-5

- - - 2H0M Specifies whether to notify 
you of a warning on the 
maintenance unit. Valid only 
when the alert in the event of 
an error is selected.

ainten-
nce Unit 
arning

Mainten-
ance Unit 
Warning 
Period 1-5

- - - Enable Specifies whether to notify 
you of a warning on the 
maintenance unit. Valid only 
when the periodical alert is 
selected.

ainten-
nce Unit 
rror

Mainten-
ance Unit 
Error Event 
1-5

- - - Immediate Specifies whether to notify 
you of an error on the 
maintenance unit. Valid only 
when the alert in the event of 
an error is selected.

ainten-
nce Unit 
rror

Maintenanc
e Unit Error 
Period 1-5

- - - Enable Specifies whether to notify 
you of an error on the 
maintenance unit. Valid only 
when the periodical alert is 
selected.

aper 
upply 
arning

Paper 
Supply 
Warning 
Event 1-5

- - - 0H15M Specifies whether to notify 
you of a warning on paper. 
Valid only when the alert in 
the event of an error is 
selected.

aper 
upply 
arning

Paper 
Supply 
Warning 
Period 1-5

- - - Enable Specifies whether to notify 
you of a warning on paper. 
Valid only when the periodical 
alert is selected.

aper 
upply 
rror

Paper 
Supply 
Error Event 
1-5

- - - Immediate Specifies whether to notify 
you of an error on paper. Valid 
only when the alert in the 
event of an error is selected.

aper 
upply 
rror

Paper 
Supply 
Error Period 
1-5

- - - Enable Specifies whether to notify 
you of an error on paper. Valid 
only when the periodical alert 
is selected.

rinting 
aper 
arning

Printing 
Paper 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on paper 
feed. Valid only when the alert 
in the event of an error is 
selected.

TEM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP
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rinting 
aper 
arning

Printing 
Paper 
Warning 
Period 1-5

- - - Disable Specifies whether to notify 
you of a warning on paper 
feed. Valid only when the 
periodical alert is selected.

rinting 
aper Error

Printing 
Paper Error 
Event 1-5

- - - 2H0M Specifies whether to notify 
you of an error on paper feed. 
Valid only when the alert in 
the event of an error is 
selected.

rinting 
aper Error

Printing 
Paper Error 
Period 1-5

- - - Enable Specifies whether to notify 
you of an error on paper feed. 
Valid only when the periodical 
alert is selected.

torage 
evice 
arning

Storage 
Device 
Event 1-5

- - - Disable Specifies whether to notify 
you of an error on the storage 
device. Valid only when the 
alert in the event of an error 
is selected.

torage 
evice 
arning

Storage 
Device 
Period 1-5

- - - Enable Specifies whether to notify 
you of an error on the storage 
device. Valid only when the 
periodical alert is selected.

rint Result 
arning

Print Result 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on an error 
affecting print results. Valid 
only when the alert in the 
event of an error is selected.

rint Result 
arning

Print Result 
Warning 
Period 1-5

- - - Enable Specifies whether to notify 
you of a warning on an error 
affecting print results. Valid 
only when the periodical alert 
is selected.

rint Result 
rror

Print Result 
Error Event 
1-5

- - - 2H0M Specifies whether to notify 
you of an error affecting print 
results. Valid only when the 
alert in the event of an error 
is selected.

rint Result 
rror

Print Result 
Error Period 
1-5

- - - Enable Specifies whether to notify 
you of an error affecting print 
results. Valid only when the 
periodical alert is selected.

nterface 
arning

Interface 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
interface. Valid only when the 
alert in the event of an error 
is selected.

nterface 
arning

Interface 
Warning 
Period 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
interface. Valid only when the 
periodical alert is selected.

TEM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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nterface 
rror

Interface 
Error Event 
1-5

- - - 2H0M Specifies whether to notify 
you of an error on the 
interface. Valid only when the 
alert in the event of an error 
is selected.

nterface 
rror

Interface 
Error Period 
1-5

- - - Enable Specifies whether to notify 
you of an error on the 
interface. Valid only when the 
periodical alert is selected.

ecurity 
arning

Security 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
security function. Valid only 
when the alert in the event of 
an error is selected.

ecurity 
arning

Security 
Warning 
Period 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
security function. Valid only 
when the periodical alert is 
selected.

canner 
arning

Scanner 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
scanner. Valid only when the 
alert in the event of an error 
is selected.

canner 
arning

Scanner 
Warning 
Period 1-5

- - - Disable Specifies whether to notify 
you of a warning on the 
scanner. Valid only when the 
periodical alert is selected.

canner 
rror

Scanner 
Error Event 
1-5

- - - Disable Specifies whether to notify 
you of an error on the 
scanner. Valid only when the 
alert in the event of an error 
is selected.

canner 
rror

Scanner 
Error Period 
1-5

- - - Disable Specifies whether to notify 
you of an error on the 
scanner. Valid only when the 
periodical alert is selected.

ax 

arninga
FAX 
Warning 
Event 1-5

- - - Disable Specifies whether to notify 
you of a warning on the fax 
function. Valid only when the 
alert in the event of an error 
is selected.

ax 

arninga
FAX 
Warning 
Period 1-5

- - - Disable Specifies whether to notify 
you of a warning on the fax 
function. Valid only when the 
periodical alert is selected.

ax Errora FAX Error 
Event 1-5

- - - Disable Specifies whether to notify 
you of an error on the fax 
function. Valid only when the 
alert in the event of an error 
is selected.

TEM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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SNMP

ax Errora FAX Error 
Period 1-5

- - - Disable Specifies whether to notify 
you of an error on the fax 
function. Valid only when the 
periodical alert is selected.

ther Error Other Error 
Event 1-5

- - - 2H0M Specifies whether to notify 
you of other errors. Valid only 
when the alert in the event of 
an error is selected.

ther Error Other Error 
Period 1-5

- - - Enable Specifies whether to notify 
you of other errors. Valid only 
when the periodical alert is 
selected.

a. MC361 and MC561 only.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Contact to 
Administra
tor

Contact to 
Admin

- - - (NULL) Specifies the contact 
information of the system 
administrator up to 225 
characters.

Printer 
Name

Printer 
Name

- - - OKI-
(machine 
name)-(last 
6 digits of 
MAC 
address)

Sets the machine name up to 
31 characters.

Printer 
Location

Printer 
Location

- - - (NULL) Sets the machine location up 
to 255 characters.

Printer 
Number

Printer 
Asset 
Number

- - - (NULL) Sets the arbitrary number to 
manage your machine up to 8 
characters.

SNMP 
Mode

SNMP 
Version

- - - SNMPv3+v1 Specifies the SNMP version.

User Name User Name - - - root Sets the user name in SNMPv3 
up to 32 characters.

Authentica
tion 
Settings 
Pass-
phrase

Auth Pass-
phrase

- - - (NULL) Sets the password to create an 
authentication key for SNMPv3 
Packet Authentication. From 8 
to 32 characters can be used.

TEM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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PRINTER TRAP

- Auth Key - - - (NULL) Sets the authentication key for 
SNMPv3 packet authentication 
in HEX code. Maximum 
number of characters differs 
depending on the algorithm 
you select.

Authentica
tion 
Settings 
Algorithm

Auth 
Algorithm

- - - MD5 Specifies the algorithm for 
SNMPv3 packet 
authentication.

Privacy 
Settings 
Pass-
phrase

Privacy 
Pass-
phrase

- - - (NULL) Sets the password to create a 
privacy key for SNMPv3 packet 
encryption. From 8 to 32 
characters can be used.

- Privacy Key - - - (NULL) Sets the authentication key for 
SNMPv3 packet encryption in 
HEX code. 16 octets (HEX code 
32 characters) can be used.

Privacy 
Settings 
Algorithm

Privacy 
Algorithm

- - - DES Specifies the algorithm for 
SNMPv3 packet encryption. 
You cannot change the value.

New SNMP 
Read 
Commun-
ity

Read 
Community

- - - public Sets the read community for 
SNMPv1 up to 15 characters.

New SNMP 
Write 
Commun-
ity

Write 
Community

- - - public Sets the write community for 
SNMPv1 up to 15 characters.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Printer 
Trap 
Commun-
ity Name

Prn-Trap 
Commun-
ity

- - - public Sets a community name for a 
printer trap up to 31 characters.

Address 
1-5

TCP #1-5 
Trap 
Address

- - - 0.0.0.0 Specifies a trap destination in 
TCP/IP. You can specify up to 5 
destinations.

Trap 
Enable 1-5

TCP #1-5 
Trap 
Enable

- - - Disable Specifies whether to use a 
printer trap in TCP #1-5.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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Printer 
Reboot 1-5

TCP #1-5 
Printer 
Reboot 
Trap

- - - Disable Specifies whether to send an 
SNMP message when the 
machine has rebooted.

Receive 
Illegal 
Packet 1-5 

TCP #1-5 
Receive 
Illegal Trap

- - - Disable Specifies whether to use a trap 
when a community name other 
than the one set in Printer Trap 
Community Name is used to 
access the machine.

Online 1-5 TCP #1-5 
Online 
Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine comes online.

Offline 1-5 TCP #1-5 
Offline 
Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine goes offline.

Paper Out 
1-5

TCP #1-5 
Paper Out 
Trap

- - - Disable Specifies whether to send an 
SNMP message when the 
machine runs out of paper.

Paper Jam 
1-5

TCP #1-5 
Paper Jam 
Trap

- - - Disable Specifies whether to send an 
SNMP message when the paper 
jams.

Cover 
Open 1-5

TCP #1-5 
Cover 
Open Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine’s cover opens.

Printer 
Error 1-5

TCP #1-5 
Printer 
Error Trap

- - - Disable Specifies whether to send an 
SNMP message when an error 
occurs.

IPX IPX Trap 
Address/
Net

- - - 00000000:
000000000
000

Specifies a trap destination in 
IPX. Specify the value as 
“(network address):(node 
address)”. You can specify only 
one address.

IPX Trap 
Enable

IPX Trap 
Enable

- - - Disable Specifies whether to use a 
printer trap in IPX.

IPX Printer 
Reboot

- - - - Disable Specifies whether to send an 
SNMP message when the 
machine has rebooted.

IPX 
Receive 
Illegal 
Packet

- - - - Disable Specifies whether to use a trap 
when a community name other 
than the one set in Printer Trap 
Community Name is used to 
access the machine.

IPX Online IPX Online 
Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine comes online.

IPX Offline IPX Offline 
Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine goes offline.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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IPP

IPX Paper 
Out

IPX Paper 
Out Trap

- - - Disable Specifies whether to send an 
SNMP message when the 
machine runs out of paper.

IPX Paper 
Jam

IPX Paper 
Jam Trap

- - - Disable Specifies whether to send an 
SNMP message when the paper 
jams.

IPX Cover 
Open

IPX Cover 
Open Trap

- - - Disable Specifies whether to send an 
SNMP message every time the 
machine’s cover opens.

IPX Printer 
Error

IPX Printer 
Error Trap

- - - Disable Specifies whether to send an 
SNMP message when an error 
occurs.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

IPP - - - - Disable Specifies whether to use IPP.

Message 
from 
admin-
istrator

- - - - (NULL) Enter a message according to 
the language selected in 
Charset and Language.

Charset - - - - UTF-8 Specifies a character set to use 
when submitting settings to the 
machine.

Language - - - - EN-US Specifies the language used in 
the settings containing text 
strings. 

Authentic
ation

- - - - NONE Specifies whether to use 
authentication when performing 
IPP printing.

User 
Name 
1-50

- - - - (NULL) If you select BASIC in 
Authentication, specify a user 
name up to 63 characters.

Password 
1-50

- - - - (NULL) If you select BASIC in 
Authentication, specify a 
password up to 16 characters.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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WINDOWS RALLY

IEEE802.1X

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG.T
OOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

WSD Print WSD Print - - - Enable Specifies whether to use WSD 
Print.

LLTD LLTD - - - Enable Specifies whether to use LLTD.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

IEEE802.1X 802.1X - - - Disable Specifies whether to use 
IEEE802.1X.

EAP Type EAP Type - - - EAP-TLS Specifies the EAP method.

EAP User EAP User - - - eapuser Specifies the user name to be 
used for EAP up to 64 
characters.

EAP 
Password

EAP 
Password

- - - (NULL) Specifies the password to be 
used for an EAP user up to 64 
characters. Valid only when 
PEAP is selected in EAP 
Type.

Client 
Certificate 
Setting

Use SSL. 
Certificate

- - - (NULL) Specifies whether to use an 
SSL/TLS certificate to 
IEEE802.1X authentication. 
It is unavailable when no 
SSL/TLS certificate is 
installed. Valid only when 
EAP-TLS is selected.

CA 
Certification 
Setting

Authentica
te Server

- - - Authenticate 
Server

Specifies whether to 
authenticate a certificate 
from the RADIUS server by a 
CA certificate. 

- EAP retry - - - 3 Specifies the number of 
retries of IEEE802.1X 
authentication.

- EAP 
timeout

- - - 40 Specifies the timeout value 
to wait for the server 
response during IEEE802.1X 
authentication.
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SECURE PROTOCOL SERVER (KERBEROS)

LDAP

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Domain Realm 
Name

- - - (NULL) Specifies the realm name for 
Kerberos authentication.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

LDAP 
Server

LDAP 
Server

- - - (NULL) Specifies the LDAP server 
name. Enter the domain name 
or IP address.

Port 
Number

LDAP Port 
Number

- - - 389 Specifies the port number of 
the LDAP server.

Timeout LDAP 
Timeout

- - - 30 Specifies the timeout value to 
wait for the LDAP server 
response.

Max. 
Entries

Max Entry - - - 100 Specifies the maximum search 
results.

Search 
Root

Search 
Root

- - - (NULL) Specifies where to search 
(BaseDN) in LDAP search.

User Name 
1

User Name 
1

- - - cn Specifies the attribute name 
searched for as the user name.

User Name 
2

User Name 
2

- - - sn

User Name 
3

User Name 
3

- - - givenName

Mail 
Address

Mail 
Address

- - - mail Specifies the attribute name 
searched for as the e-mail 
address.

Additional 
Filter

Additional 
Filter

- - - (NULL) Specifies additional filters for 
LDAP search.

Method Authentica
tion 
Method

- - - Anonymous Specifies the authentication 
method for LDAP server.

User ID Authentica
tion User 
ID

- - - (NULL) Sets a user ID to access the 
LDAP server.
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MAIL SERVER

Password Authentica
tion User 
Password

- - - (NULL) Sets a password to access the 
LDAP server.

Encryption Encryption 
Algorithm

- - - None Specifies the method to encrypt 
LDAP communication.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

SMTP 
Server

SMTP 
Server 
Name

- - - (NULL) Specifies the SMTP server name. 
Specify the domain name or IP 
address.

Be sure to configure DNS settings 
when you enter a domain name.

SMTP Port SMTP Port 
Number

- - - 25 Specifies the SMTP port number.

SMTP 
Encryption

SMTP 
Encryption 
Algorithm

- - - None Specifies the method for 
encrypting the SMTP (E-mail) 
send protocol.

POP3 
Server

POP3 
Server

- - - (NULL) Specifies the POP server name. 
Enter the domain name or IP 
address.

POP3 Port POP port 
number

- - - 110 Specifies the port number to 
access the POP server.

POP 
Encryption

POP 
Encryption 
Algorithm

- - - None Specifies the method to encrypt 
POP communication.

Authentica
tion 
method

SMTP Auth - - - None Specifies whether to perform 
SMTP authentication.

SMTP 
UserID

User ID - - - (NULL) Sets a user ID for SMTP 
authentication method.

SMTP 
Password

User 
Password

- - - (NULL) Sets a password for SMTP 
authentication.

POP 
UserID

POP3 
Server 
UserID

- - - (NULL) Sets a user ID to access the POP 
server.

POP 
Password

POP3 
Server 
Password

- - - (NULL) Sets a password to access the 
POP server.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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SECURITY

TEM DEFAUL
T VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

TCP/IP - - - Enable Specifies whether to use TCP/IP.

etBEUI NetBEUI - - - Disable Specifies whether to use 
NetBEUI.

etBIOS 
ver TCP

NetBIOS 
over TCP

- - - Enable Specifies whether to use 
NetBIOS over TCP.

etWare NetWare - - - Disable Specifies whether to use 
NetWare.

therTalk EtherTalk - - - Disable Specifies whether to use 
EtherTalk.

eb (Port 
o.: 80)

Web 
(Default 
Port 80)

Device 
Settings
(Web)-
Enable

Printer 
Web Page 
-Enable

Web Page 
Settings

Enable Specifies whether to use the web
page to access the machine.

eb Web (IPP) - - - 80 Specifies the port number to 
access the web page of the 
machine.

P (Port 
o.: 631)

IPP 
(Default 
Port 631)

- - - Disable Specifies whether to use IPP.

lnet Telnet - - - Disable Specifies whether to use TELNET
to access the machine.

TP FTP - - - Disable Specifies whether to use FTP to 
access the machine.

NMP SNMP - - - Enable Specifies whether to use SNMP 
to access the machine.

OP POP (E-
Mail)

- - - Disable Specifies whether to use POP3.

OP POP - - - 110 Specifies the port number for 
POP3.

NTP SNTP - - - Disable Specifies whether to use SNTP.

cal Ports Local Ports - - - Enable Specifies whether to use a 
unique protocol.

SMTP 
(E-Mail)

- - - Enable Specifies whether to use SMTP 
send.

MTP 
end Port 
umber

SMTP 
Send

- - - 25 Specifies the port number for 
SMTP send.

MTP 
eceive 
ort 
umber

SMTP 
Receive

- - - 25 Specifies the port number for 
SMTP receive.
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IP FILTERING

etwork 
assword 
onfigur-
tion

Password Change 
Password

Change 
Password

Change 
Password

Last 6 
digits of 
MAC 
address

Sets a new administrator 
password up to 15 characters. 
The password is case-sensitive. 
This password is used only when
you change settings from the 
utilities. The administrator 
password set in the machine 
cannot be changed from this 
item.

EM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

 Filtering IP Filtering - - - Disable Specifies whether to use IP filtering
Be sure to configure the following 
settings of this category when you 
enable IP filtering.

If you do not, you cannot access the
machine via TCP/IP at all.

art 
dress 
10

Start 
Address 
#1-10

- - - 0.0.0.0 Specifies IP addresses which are 
allowed to access the machine. You
can specify an individual address or
an address range.

d 
dress 
10

End 
Address 
#1-10

- - - 0.0.0.0

inting 
10

IP Address 
Range #1-
10 Printing

- - - Disable Specifies whether to allow print jobs
from specified IP addresses.

nfig 
10

IP Address 
Range #1-
10 
Configur-
ation

- - - Disable Specifies whether to allow the 
configuration from specified IP 
addresses.

ministra
r’s IP 
dress 
tting

Admin IP 
Address

- - - 0.0.0.0 Specifies the administrator IP 
address automatically. Only this 
address can always access the 
machine. 

When the administrator accesses 
the machine via a proxy server, all 
access via the proxy server is 
allowed.

TEM DEFAUL
T VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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MAC ADDRESS FILTERING

SSL/TLS

EM DEFAULT 
VALUE

DESCRIPTION

EB 
AGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

AC 
ddress 
ltering

MAC 
Address 
Filtering

- - - Disable Specifies whether to use MAC 
address filtering. This function uses
Ethernet addresses for filtering. Be
sure to configure the following 
settings of this category when you
enable MAC address filtering.

If not, you cannot access the 
machine via a network at all.

ommunic
ion from 
e 
llowing 
AC 
ddresses

MAC 
Address 
Access

- - - Accept Specifies whether to accept or 
block the access from specified 
MAC addresses.

AC 
ddress 
50

MAC 
Address 
#1-50

- - - 00:00:00:0
0:00:00

Specifies MAC addresses to which 
the filtering is applied.

dministra
r’s MAC 
ddress 
tting

Admin 
MAC 
Address

- - - 00:00:00:0
0:00:00

Specifies the administrator MAC 
address automatically. Only this 
address can always access the 
machine.

When the administrator accesses 
the machine via a proxy server, all
access via the proxy server is 
allowed.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

SSL/TLS Cipher 
(SSL/TLS)

- - - OFF Specifies whether to encrypt 
SSL/TLS communication.

Cipher 
Strength

Cipher 
Strength

- - - Standard Specifies the strength of the 
encryption.

HTTP/IPP 
Receive

HTTP/IPP - - - OFF Specifies whether to encrypt 
reception via HTTP/IPP.

HTTP/IPP 
Receive 
Cipher 
Strength

HTTP/IPP 
Cipher 
Strength

- - - Standard Specifies the strength of the 
encryption of reception via 
HTTP/IPP.

FTP 
Receive

FTP 
Receive

- - - OFF Specifies whether to encrypt 
reception via FTP.
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FTP 
Receive 
Cipher 
Strength

FTP 
Receive 
Cipher 
Strength

- - - Standard Specifies the strength of the 
encryption of reception via 
FTP.

SMTP 
Receive

SMTP 
Receive

- - - OFF Specifies whether to encrypt 
reception via SMTP.

SMTP 
Receive 
Cipher 
Strength

SMTP 
Receive 
Cipher 
Strength

- - - Standard Specifies the strength of the 
encryption of reception via 
SMTP.

Select 
Certificate 
type

- - - - Using self-
signed 
Certificate

Creates a self-signed 
certificate. And also creates a 
CSR to send to a certificate 
authority and installs a 
certificate issued by it.

Common 
Name

- - - - (Machine’s 
IP Address)

The machine’s IP address is 
specified when you create a 
self-signed certificate.

Organizati
on

- - - - (NULL) Specifies the official 
organization name you belong 
to up to 64 characters.

Organizati
onal Unit

- - - - (NULL) Specifies the sub-group name 
such as a branch you belong 
to up to 64 characters.

Locality - - - - (NULL) Specifies the country or 
region name you are in up to 
128 characters.

State/
Province

- - - - (NULL) Specifies the state or province 
name you are in up to 128 
characters.

Country/
Region

- - - - (NULL) Specifies the country or 
region code in 2 characters.

Key 
Exchange 
method

- - - - RSA Specifies the key method for 
encrypted communication.

Key size - - - - 1024bit Specifies the key size for 
encrypted communication.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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IPSEC

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

IPSec IPSec - - - Disable Specifies whether to use IPSec.

IP Address 
1-50

- - - - 0.0.0.0 Specifies the host allowed to 
communicate in IPSec.

IKE 
Encryption 
Algorithm

- - - - 3DES-CBC Specifies the IKE encryption 
method.

IKE Hash 
Algorithm

- - - - SHA-1 Specifies the IKE Hash method.

Diffie-
Hellman 
Group

- - - - Group2 Specifies the Diffie-Hellman 
group for “Phrase 1 Proposal”.

LifeTime - - - - 28800 
(seconds)

Specifies the life time for 
“ISAKMP SA”.

Pre-
Shared 
Key

- - - - (NULL) Specifies the pre-shared key.

Key PFS - - - - NOPFS Specifies whether to use Key 
PFS (Perfect Forward Secrecy).

Key PFS 
Diffie-
Hellman 
Group

- - - - None Specifies the Diffie-Hellman 
group for Key PFS.

ESP - - - - Enable Specifies whether to use ESP 
(Encapsulating Security 
Payload).

ESP 
Encryption 
Algorithm

- - - - 3DES-CBC Specifies the encryption 
algorithm for ESP.

ESP 
Authentica
tion 
Algorithm

- - - - SHA-1 Specifies the authentication 
algorithm for ESP.

AH - - - - Enable Specifies whether to use AH 
(Authentication Header).

AH 
Authentica
tion 
Algorithm

- - - - SHA-1 Specifies the authentication 
algorithm for AH.

LifeTime - - - - 3600 
(seconds)

Specifies the life time for 
“IPSec SA”.
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MAINTENANCE

TIME SETUP (SNTP SETTINGS)

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Reset 
Network 
Card

Reset 
Network 
Card

- - - Disable Select to reset Network Card.

Reset 
Network 
Card to 
Factory 
Defaults

Reset 
Network 
Card to 
Factory 
Defaults

- - - Disable Select to restore the factory 
default settings.

LAN Scale 
Setting

LAN Scale 
Setting

- - - Normal Use the default value. SMALL 
is recommended only when 
you use a small LAN to which a 
few computers are connected.

Network 
PS-
Protocol

- - - - RAW Specifies the format of 
PostScript data for the 
network port.

HEX Dump HEX Dump 
Mode

- - - NO Specifies whether to show the 
received print data in 
hexadecimal number.

Restarting the machine 
disables this mode.

HUB Link 
Setting

HUB Link 
Setting

- - - AUTO 
NEGOTIAT-
ION

Specifies the speed and 
method of communication 
between the hub and the 
machine.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Time 
Setup

- - - - Manual Specifies how to set date and 
time, manually or 
automatically.

SNTP 
Server 
(Primary)

NTP 
Server 
(Pri.)

- - - (NULL) Specifies the IP address of the 
primary NTP server to get the 
current time.

SNTP 
Server 
(Second-
ary)

NTP 
Server 
(Sec.)

- - - (NULL) Specifies the IP address of the 
secondary NTP server to get 
the current time.
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WEB PRINTING

Adjust 
Interval

Adjust 
Interval

- - - 1 (hour) Specifies how often the 
machine should adjust the 
time.

Time Zone Local Time 
Zone

- - - 00:00 Sets the time lag between GMT 
and your local time.

Set 
Daylight 
Saving

Daylight 
Saving

- - - OFF Sets daylight saving time.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)

Paper tray - - - - Tray 1 Specifies the tray to be used for 
print jobs.

Copies - - - - 1 Specifies the number of copies.

Collate - - - - Enable Specifies whether to collate the 
output.

Fit to page - - - - Enable Specifies whether to fit the 
document size to the paper size.

Duplex 
printing

- - - - None Specifies whether to and how to 
bind a duplex job.

Page 
Select

- - - - Disable Specifies the pages to be 
printed.

PDF 
Password

- - - - Disable Select this item and enter the 
password necessary when you 
print an encrypted PDF file.

ITEM DEFAULT 
VALUE

DESCRIPTION

WEB 
PAGE

TELNET CONFIG. 
TOOL 
NETWORK 
SETTING 
PLUG-IN

NETWORK CARD 
SETUP

(WIN.) (MAC)
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CHANGING NETWORK SETTINGS FROM THE WEB PAGE

This section explains how to change the network settings from the machine’s web page. 
This function is available on Windows and Mac.

To access the machine’s web page, your computer must meet the following conditions:

> TCP/IP is enabled

> Microsoft Internet Explorer 6 or later, Safari 3.0 or later, or Firefox 3.0 or later is 
installed

> Be sure that the security setting for a web browser is set to the middle level or 
cookies are allowed. 

> To enter the Admin Setup menu, the administrator password is necessary. The 
default password is “aaaaaa”.

ENCRYPTING COMMUNICATION BY SSL/TLS

You can encrypt the communication between your computer and the machine.

The communication is encrypted by SSL/TLS when you change the machine settings from 
the web page, perform the IPP printing, direct print, or LDAP search, and print data 
received via SMTP or FTP.

Creating a certificate

You can create a certificate on the web page. The following two certificates are available:

> A self-signed certificate

> A certificate created by a certificate authority

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Security > SSL/TLS.

4. Follow the on-screen instructions to specify the detailed settings.

5. Click OK.

6. Check the settings and click OK.

7. If you are creating a self-signed certificate, go to “Enabling encryption” on page 68 
to enable encryption.
If you are getting a certificate created by a certificate authority, go to step 8.

8. Follow the on-screen instructions to send a CSR to a certificate authority.

NOTE
Some of the following settings can be performed on other utilities. For details, 
“Network setting items” on page 42.

NOTE
If you change the machine IP address after you create a certificate, the 
certificate becomes invalid. Be sure not to change the machine’s IP address 
after creating a certificate.

NOTE
The machine’s IP address is set to Common Name.
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9. Click Export Certificate.

10. Perform steps 1 to 3 in “Creating a certificate” on page 67 to enter the encryption 
screen.

11. Follow the on-screen instructions to install a certificate from the certificate authority.

12. Click Submit.

13. Go to “Enabling encryption” on page 68 to enable encryption.

Enabling encryption

After you creating a certificate, perform the following procedure to enable encryption.

When you enable encryption, the communication is encrypted the next time you change 
the settings from the web page.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Security > Protocol ON/OFF.

4. Select Enable for the desired protocol.

5. Click Submit.

Launching the web page

1. Launch a web browser.

2. Type the IP address of the MFP in the URL field of your browser and then press 
Enter. For example http://10.18.207.102

MC561

OKI-MC561-6894A2
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IPP PRINTING (WINDOWS ONLY)

IPP printing allows you to transmit your print job data from your computer to the machine 
via the Internet.

Enabling IPP Printing

IPP printing is disabled by factory default. To perform IPP printing, enable IPP first.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > IPP.

4. Select Enable.

5. Click Submit.

Setting up your machine as an IPP printer

Add your machine as an IPP printer to your computer.

1. Click Start and select Devices and Printers > Add a printer.

2. Select Add a network, wireless or Bluetooth printer on the Add Printer wizard.

3. In the list of available printers, select The printer that I want isn't listed.

4. Choose Select a shared printer by name.

5. Enter “https://your machine IP address/ipp” or “https://your machine IP 
address/ipp/lp” and then click Next.

6. Click Have Disk.

7. Insert the DVD that was supplied with your machine into the DVD-ROM drive.

8. Enter the following value in Copy from:

> For PCL driver, “D:\Drivers\ENU\PCL”.

> For PS driver, “D:\Drivers\ENU\PS”.

> For PCL XPS driver, “D:\Drivers\ENU\XPS”.

9. Click OK.

10. Select the desired printer and click OK.

11. Select Yes in Use this printer as default and click Next.

12. If the Share this printer wizard appears, select Do not share and then click Next.

13. Select No in Print test page? and click Next.

14. Click Finish.

NOTE
The following OSs are supported; Windows 7, Windows Server 2008 R2, 
Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, 
and Windows 2000.

This procedure uses Windows 7 as an example. The procedures and menus 
may differ depending on the OS you use.

NOTE
The values above are the example of when the DVD-ROM drive is set to the 
D drive.
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15. On the Hardware Install screen, click Continue.

16. When the installation finishes, print a test page.

Performing IPP printing

1. Open an application file.

2. From the File menu, select Print.

3. From Select Printer, select the created IPP printer and then click Print.

NOTE
The following procedure is explained using NotePad as an example. The 
procedures and menus may differ depending on the application you use.
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ENCRYPTING COMMUNICATION BY IPSEC

You can encrypt the communication between your computer and the machine.

The communication is encrypted by IPSec. When IPSec is enabled, encryption is applied to 
all the applications using the IP protocols.

You can specify up to 50 hosts by their IP addresses. When a host that is not registered 
tries to access the machine, it is rejected. When you try to access a host that is not 
registered, it is invalid.

You must have a pre-shared key in advance.

Configuring your machine

Be sure to configure your machine first from the web page to enable IPSec.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Security > IPSec.

4. Follow the on-screen instructions to specify the detailed settings.

5. Click Submit.

The network system reboots to enable the new settings.

Configuring your computer

Be sure to configure your machine in advance before configuring your computer.

1. Click Start and select Control Panel > Administrative Tools.

2. Double-click Local Security Policy.

3. On the Local Security Policy window, click IP Security Policies on Local 
Computer.

4. From the Action menu, select Create IP Security Policy.

5. On the IP Security Policy Wizard, click Next.

NOTE
> When you enable IPSec, the communication to and from a host that is not 

specified in this procedure is rejected.

> Be sure to memorize the values specified in this procedure. They are 
necessary when you configure the IPSec setting on your computer.

NOTE
Either ESP or AH must be enabled in the configuration for “Phase2 Proposal”.

NOTE
If you fail to set up IPSec due to the mismatch of the specified parameter, you 
cannot access the web page. In this case, disable IPSec from the control panel 
of the machine or initialize the network settings.

NOTE
This procedure uses Windows 7 as an example. The procedures and menus 
may differ depending on the OS you use.
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6. Enter a Name and a Description and then click Next.

7. Clear the Activate the default response rule (earlier versions of Windows 
only). check box and then click Next.

8. Select Edit properties and then click Finish.

9. On the IP security policy properties window, select the General tab.

10. Click Settings.

11. On the Key Exchange Settings window, enter the value (minutes) in 
Authenticate and generate a new key after every.

12. Click Methods.

13. On the Key Exchange Security Methods window, click Add.

14. Specify Integrity algorithm, Encryption algorithm, and Diffie-Hellman group.

15. Click OK.

16. On the Key Exchange Security Methods window, click OK.

17. On the Key Exchange Settings window, click OK.

18. On the IP security policy properties window, select the Rules tab.

19. Click Add.

20. On the Security Rule Wizard, click Next.

21. On the Tunnel Endpoint screen, make sure that This rule does not specify a 
tunnel is selected and then click Next.

22. On the Network Type screen, make sure that All network connections is 
selected and then click Next.

23. On the IP Filter List screen, click Add.

24. On the IP Filter List window, click Add.

25. On the IP Filter Wizard, click Next.

26. On the IP Filter Description and Mirrored Property screen, click Next.

27. On the IP Traffic Source screen, click Next.

28. On the IP Traffic Destination screen, click Next.

29. On the IP Protocol Type screen, click Next.

30. Click Finish.

31. On the IP Filter List wizard, click OK.

32. On the Security Rule Wizard, select the new IP filter from the list and then click 
Next.

33. On the Filter Action screen, click Add.

NOTE
Specify the same value as Life time specified in the configuration for “Phase1 
Proposal” in “Configuring your machine” on page 71. Although Life time is 
specified by seconds, enter a value by minutes in this step.

NOTE
Select the same value specified in IKE Encryption Algorithm, IKE Hash 
Algorithm, and Diffie-Hellman group in the configuration for “Phase1 
Proposal” in “Configuring your machine” on page 71.
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34. On the Filter Action Wizard, click Next.

35. On the Filter Action Name screen, enter a Name and a Description and then click 
Next.

36. On the Filter Action General Options screen, make sure that Negotiate security 
is selected and then click Next.

37. On the Communicating with computers that do not support IPsec screen, 
make sure that Do not allow unsecured communication. is selected and then 
click Next.

38. On the IP Traffic Security screen, select Custom and then click Settings.

39. On the Custom Security Method Settings window, configure the settings and 
then click OK.

40. On the IP Traffic Security screen, click Next.

41. Select Edit properties and then click Finish.

42. On the filter action properties window, select Use session key perfect forward 
secrecy (PFS) if you want to enable Key PFS.

43. Select Accept unsecured communication, but always respond using IPsec if 
you perform IPSec communication by the IPv6 global address.

44. Click OK.

45. Select the new filter action and then click Next.

46. On the Authentication Method screen, select the value you want and then click 
Next.

47. Click Finish.

48. On the IP security policy properties window, click OK.

49. On the Local Security Policy window, select the new IP security policy.

50.  From the Action menu, select Assign.

51. Make sure that Policy Assigned for the new IP security policy is displayed as Yes.

52. Click X on the Local Security Policy screen.

NOTE
Select the same values specified in the configuration for “Phase2 Proposal” in 
“Configuring your machine” on page 71.
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CONTROLLING ACCESS USING IP ADDRESS (IP FILTERING)

You can control access to the machine using the IP address. You can set whether to allow 
configuration or printing from the specified IP addresses. By factory default, IP filtering is 
disabled.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Security > IP Filtering.

4. Follow the on-screen instructions to specify the detailed settings.

5. Click Submit.

The network system reboots to enable the new settings.

CONTROLLING ACCESS USING MAC ADDRESS (MAC ADDRESS FILTERING)

You can control access to the machine using the MAC address. You can allow or reject the 
access from the specified MAC addresses.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Security > MAC Address Filtering.

4. Follow the on-screen instructions to specify the detailed settings.

5. Click Submit.

The network system reboots to enable the new settings.

NOTE
Be sure to specify the correct IP address. If you specify a wrong IP address, 
you cannot access the machine using the IP protocol.

When you enable IP filtering, the access to and from a host that is not specified 
in this procedure is rejected.

You can use only IPv4 for IP filtering.

NOTE
If nothing is registered in Administrator’s IP Address setting, you may not 
be able to access the machine depending on the specified IP address range.

Your Current Local Host/Proxy IP Address and the IP address of your 
host may not match if you use a proxy server.

NOTE
Be sure to specify the correct MAC address. If you specify the wrong MAC 
address, you cannot access the machine via a network.

You cannot individually specify acceptance or rejection for each address.

NOTE
If nothing is registered in Administrator’s MAC Address setting, you may 
not be able to access the machine depending on the specified MAC address.

Your Current Local Host/Proxy MAC Address and the MAC address of 
your host may not match if you use a proxy server.
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ERROR NOTIFICATION BY E-MAIL (E-MAIL ALERT)

You can set the machine to send an error notification e-mail when an error happens. You 
can set when to be notified:

> On a regular basis

> Only when an error occurs

Configuring your machine

You can configure the settings for e-mail alert using the web page.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > E-mail > Send Settings.

4. Follow the on-screen instructions to specify the detailed settings.

5. Select Set detail of the SMTP Protocol..

6. If necessary, you can configure Security settings, Configure attached 
information, and Others.

7. Click Submit.

The network system reboots to enable the new settings.

Regular alert

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > E-mail > Alert Settings.

4. Enter an e-mail address to receive the alerts.

5. Click Setting for the specified address.

Copy is useful when you want to apply the alert conditions to another address.

6. Follow the on-screen instructions to specify the detailed settings.

7. Click OK.

8. Click View a summary of current configuration to check the current settings, 
and then click X to close the window.

You can also check the current settings of up to two addresses on the main window. 
Select the desired addresses from the list box.

9. Click Submit.

NOTE
When you specify a domain name in SMTP Server, configure the DNS server 
in the TCP/IP setting.

You need to set the mail server to allow the machine to send an e-mail. For 
details on the mail server setting, refer to your network administrator.

When you use Internet Explorer 7, select Tools > Internet Options, click 
Custom level on the Security tab, and then select Enable in Allow 
websites to prompt for information using scripted windows to send a 
test e-mail.
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The network system reboots to enable the new settings.

Alert when an error occurs

1. Perform steps 1 to 6 in “Regular alert”.

2. Specify the time lag between when an error occurs and when the alert is sent.

If you specify a longer time, only continuing errors are notified.

3. Click OK.

4. Click View a summary of current configuration to check the current settings, 
and then click X to close the window.

You can also check the current settings of up to two addresses on the main window. 
Select the desired addresses from the list box.

5. Click Submit.

The network system reboots to enable the new settings.

USING SNMPV3
The SNMPv3 manager supporting SNMPv3 encrypts the management of the machine by 
SNMP.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > SNMP > Setting.

4. Follow the on-screen instructions to specify the detailed settings.

5. Click Submit.

The network system reboots to enable the new settings.

NOTE
If there is no error specified, the alert e-mail in not sent.

NOTE
Your machine has an SNMP agent. You can check and change the machine 
settings by a commercially available SNMP agent. For the MIB of the machine, 
refer to the DVD supplied with your machine and check “Readme.text” in the 
MISC > Mib folder.
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USING IPV6
Your machine supports IPv6. The machine gets an IPv6 address automatically. You cannot 
set the IPv6 address manually. 

The machine supports the following protocols:

> For Printing:

> LPR

> IPP

> RAW (Port9100)

> FTP

> For Configuration:

> HTTP

> SNMPv1/v3

> Telnet

The table below shows the protocols that are supported:

*1) To specify a host name, edit the hosts file or access via the DNS server.

*2) You cannot specify a host name by the DNS server when you enable only IPv6 on Telnet.

*3) You cannot specify a host name when you use a link local address to access.

*4) Enter an IPv6 address enclosed with brackets.

NOTE
To enter the Admin Setup menu, the administrator password is necessary. 
The default password is “aaaaaa”.

PROTOCOL OS APPLICATION LIMITATIONS

LPD • Windows 7
• Windows Vista
• Windows XP

LPR (Command Prompt) *1, 2, 3

FTP • Windows 7
• Windows Vista
• Windows XP

FTP (Command Prompt) *1, 2, 3

• Mac OS X FTP (Terminal) *1, 2, 3

HTTP • Windows 7
• Windows Vista
• Windows XP

Internet Explorer 6.0/7.0 *1, 2, 3

• Mac OS X Safari (2.0-v412.2) *1, 2, 3, 4

Telnet • Windows 7
• Windows Vista
• Windows XP

Telnet (Command Prompt) *1, 2, 3

• Mac OS X FTP (Terminal) *1, 2, 3

NOTE
To use IPv6 on Windows XP, install IPv6.
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ENABLING IPV6

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > TCP/IP.

4. Select Enable for IPv6.

5. Click Submit.

The network system reboots to enable the new settings.

CHECKING IPV6 ADDRESS

The IPv6 address is automatically assigned.

1. Select View Info.

2. Select Network > TCP/IP.

USING IEEE802.1X
Your machine supports the IEEE802.1X authentication.

Be sure to set up your machine and computer in advance before performing the following 
procedure.

CONFIGURING YOUR MACHINE FOR IEEE802.1X

Using PEAP

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > IEEE802.1X.

4. Select Enable for IEEE802.1X.

5. Select PEAP for EAP Type.

6. Enter a user name in EAP User.

7. Enter a password in EAP Password.

8. Select Authenticate Server and then click Import.

9. Enter the file name of the CA certificate and then click OK.

Specify the certificate issued by the certificate authority from which the RADIUS 
server got it. A PEM, DER, and PKCS#7 file can be imported.

NOTE
When the global address is displayed with only “0”, it may be an error due to 
the router you use.

You can also check the IPv6 address in the network report from the machine 
by pressing the SETTING key and then selecting Reports > System > 
Network Information.

NOTE
For details on the initial setup and the IP address, refer to “Configuring the 
network settings” on page 9.
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10. Click Submit.

The network system reboots to enable the new settings.

11. When the standby screen appears on the machine, turn off the machine.

12. Go to “Connecting your machine to authentication switch” on page 79.

Using EAP-TLS

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > IEEE802.1X.

4. Select Enable for IEEE802.1X.

5. Select EAP-TLS for EAP Type.

6. Enter a user name in EAP User.

7. Select Not use SSL/TLS Certificate for EAP authentication and then click 
Import.

8. Enter the file name of the certificate.

Only a PKCS#12 file can be imported.

9. Enter the password of the certificate and then click OK.

10. Select Authenticate Server and then click Import.

11. Enter the file name of the CA certificate and then click OK.

Specify the certificate issued by the certificate authority from which the RADIUS 
server got it. A PEM, DER, and PKCS#7 file can be imported.

12. Click Submit.

The network system reboots to enable the new settings.

13. When the standby screen appears on the machine, turn off the machine.

14. Go to “Connecting your machine to authentication switch” on page 79.

CONNECTING YOUR MACHINE TO AUTHENTICATION SWITCH

1. Make sure that the machine is turned off.

2. Connect an Ethernet cable to the network interface port.

3. Connect the Ethernet cable to the authentication port of an authentication switch.

4. Turn on the machine.

5. Set up the machine.

NOTE
For details on the initial setup, refer to “Configuring the network settings” on 
page 9.
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CONFIGURING LDAP SERVER

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > LDAP.

4. Enter the domain name or IP address of the LDAP server in LDAP Server.

5. Enter the port number of the LDAP server in Port Number.

6. Specify a value for time-out to wait for the search results in Timeout.

7. Specify a value for the maximum entry of the search results in Max. Entries.

8. Specify a BaseDN to access the LDAP server in Search Root.

9. Enter attribute names to be searched for as the user name in User Name.

Be sure to specify a value for Name 1.

10. Enter an e-mail address to be searched for in Mail Address.

11. If necessary, specify a search condition in Additional Filter.

12. Select the authentication method you want in Method.

> When you select Anonymous or Simple, user authentication using LDAP fails. 
You need to select Digest-MD5 or Secure Protocol if you configure the LDAP 
server for user authentication.

> When you select Digest-MD5, you need to configure the DNS server setting.

> When you select Secure Protocol, you need to configure the DNS server and the 
secure protocol server settings.

13. If you do not select Anonymous in step 12, specify the user ID and password to log 
in to the LDAP server.

14. Select a value in Encryption.

15. Click Submit.

The network system reboots to enable the new settings.

CONFIGURING SECURE PROTOCOLS

Authentication using the Kerberos server is available when you access the LDAP server. Be 
sure to complete the SNTP and DNS server settings to use the secure protocol.

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > Secure Protocol Server.

4. Enter a realm name in Domain.

5. Click Submit.

The network system reboots to enable the new settings.

NOTE
For details on the LDAP server and encryption settings to be specified, refer to 
your network administrator.
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PRINTING WITHOUT PRINTER DRIVER (DIRECT PRINTING)

PRINTING PDFS

You can print PDFs without a printer driver. Specify the file you want to print on the web 
page and submit it to the machine.

1. Access the machine’s web page and log in as the administrator.

2. Select Direct Print.

3. Select Web Printing.

4. Follow the on-screen instructions to specify the detailed settings.

5. Check the settings and then click OK.

6. Click Print.

CONFIGURING SERVER TO PRINT FILES ATTACHED TO E-MAILS

You can print attached files when the machine receives an e-mail.

Configuration for POP

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > E-mail > Receive Settings.

4. Select POP3 and then click To STEP2.

5. Follow the on-screen instructions to specify the detailed settings.

NOTE
> It may be necessary to install additional RAM in order to print some PDF 

files.

> If you have problems printing a PDF file, open the file in Adobe Reader 
and print it.

NOTE
> When you have performed the initial setup described in “Configuring the 

network settings” on page 9, the server settings are finished.

> Up to 10 files and a maximum of 8 MB for each file can be printed.

> PDF, JPEG, and TIFF files can be printed.

> It may be necessary to install additional RAM in order to print some PDF 
files.

> If you have problems printing a PDF file, open the file in Adobe Reader 
and print it.

NOTE
Be sure to specify the correct value for your mail server. If you enable APOP 
when your mail server does not support the APOP protocol, e-mails may not 
be correctly received.

When you specify a domain name for the mail server, configure the DNS 
server in the TCP/IP setting.
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6. Click Submit.

Configuration for SMTP

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > E-mail > Receive Settings.

4. Select SMTP and then click To STEP2.

5. Follow the on-screen instructions to specify the detailed settings.

6. Click Submit.

CHANGING SETTINGS ON ETHERTALK (MAC ONLY)

CHANGING ETHERTALK MACHINE NAME

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > EtherTalk.

4. Enter a new name in EtherTalk Printer Name.

5. Click Submit.

CHANGING ETHERTALK ZONE

1. Access the machine’s web page and log in as the administrator.

2. Select Admin Setup.

3. Select Network > EtherTalk.

4. Enter a new zone name in EtherTalk Zone Name.

5. Click Submit.

NOTE
When the POP server does not support the SSL encryption, e-mails may not 
be correctly received.

NOTE
Be sure to specify a zone in the same segment.
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OTHER OPERATIONS
This section explains how to initialize the network settings and how to setup your machine 
and computer to use DHCP.

INITIALIZING NETWORK SETTINGS

1. Press the SETTING key.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Enter the administrator password.

4. Select Enter and then press OK.

5. Using the arrow keys, scroll to Network Menu and then press OK.

6. Make sure that Network Setup is selected and then press OK.

7. Using the arrow keys, scroll to select Factory Defaults and then press OK.

8. Press OK.

9. Using the arrow keys, highlight Yes to continue or No to exit and then press OK.

The machine restarts to enable the new settings.

USING DHCP
You can get an IP address from the DHCP server.

CONFIGURING DHCP SERVER

DHCP assigns an IP address to each host on the TCP/IP network.

1. Click Start > Server Manager.

If DHCP Server is already displayed, go to step 8.

2. Select Add Roles on the Roles Summary area.

3. On the Add Roles Wizard, click Next.

4. Select DHCP Server and click Next.

NOTE
This procedure initializes all the network settings.

NOTE
> You must be authorized as the administrator.

> If you enter a wrong IP address, the network system may go down.

> You can also get an IP address from the BOOTP server.

NOTE
The machine must have a static IP address if you want to print via a network. 
For details on how to assign a static IP address, refer to the manual of your 
DHCP server.

The following OSs are supported; Windows Server 2008 R2, Windows Server 
2008, and Windows Server 2003

The following procedure uses Windows Server 2008 as an example. The 
procedures and menus may differ depending on the OS you use.
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5. Follow the on-screen instructions and configure the settings as necessary.

6. On the Confirm Installation Selections screen, check the settings and click 
Install.

7. When the installation finishes, click Close.

8. Click Start and select All Programs > Administrative Tools > DHCP to launch 
the DHCP wizard.

9. On the DHCP list, select a server to use.

10. From the Action menu, select New Scope.

11. On the New Scope Wizard, follow the on-screen instructions and configure the 
settings as necessary.

> Be sure to configure the default gateway settings.

> On the Activate Scope screen, select Yes, I want to activate this scope now. 

12. Click Finish.

13. Select the new scope from the DHCP list and then select Reservations.

14. From the Action menu, select New Reservation.

15. Configure the settings.

16. Click Add.

17. Click X to close the DHCP wizard.

CONFIGURING YOUR MACHINE

The following explains how to configure your machine to use DHCP/BOOTP. By factory 
default, the DHCP/BOOTP protocol is enabled, so you do not have to perform this 
procedure.

1. Turn on the machine.

2. Turn on your computer.

3. Insert the Software DVD-ROM into the DVD drive.

The Setup Utility starts automatically. if it does not start, double-click setup.exe (in 
the root directory) on the DVD-ROM.

4. Choose your language.

5. Select your model and then click Next.

6. Read the license agreement and click I Agree.

7. Select Device Configuration > Network Card Setup.

8. Select your machine from the list.

9. From the Setting menu, select Setting Printer.

10. Enter the IP address and then click OK.

NOTE
The following procedure is explained using Network Card Setup and Windows 
7 as an example. The procedures and menus may differ depending on the OS 
you use.
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11. Enter the password for Password and then click OK.

12. Click OK on the confirmation window.

The machine restarts to enable the new settings. During the restart, the machine 
status icon changes to red. When the machine has restarted and the new settings 
have been enabled, the status icon changes to green.

13. From the File menu, select Exit to close Network Card Setup.

NOTE
The initial password is the last six digits of the Ethernet address.

The password is case-sensitive.
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APPENDIX A - MENU SYSTEM
The top-level function menus are:

> Reports

> Paper setup

> Address book

> Phone book

> Profile

> Network scan destination

> Store document settings

> View information

> Shutdown

> Easy setup

> Admin setup

The menu trees are given to the lowest menu item level. Typically, this can be a parameter 
that can be set by selecting from a range of values provided or a command that can be 
executed to display or print a status or setting value.
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REPORTS

ITEM OPTION OPTION/DESCRIPTION

Configuration Yes, No Prints out a report of the machine’s 
configuration

System File List Yes, No Prints out a file list

Demo Page 01:DEMO1 Yes, No Prints a 
Demonstration page

Error Log Yes, No Prints out an error log

MFP Usage Yes, No Prints a full report of the machine usage.

Network 
Information

Yes, No Prints out a report of the Network 
configuration

Faxa

a. MC361 and MC561 only.

Speed Dial List Enter the Admin 
Password

Yes, No Prints the list of fax 
numbers registered 
for speed dials.

Group List Enter the Admin 
Password

Yes, No Prints the list of fax 
numbers registered 
under groups.

Fax Tx/Rx Log Enter the Admin 
Password

Yes, No Prints the list of the 
communication 
results for the latest 
100 fax jobs 
received or sent.

Fcode Box List Yes, No Prints the list of fcode boxes.

E-mail/Internet Fax Journal Report Enter the Admin 
Password

Yes, No Prints the results of 
the latest 50 
Internet Fax jobs.

Address Book Enter the Admin 
Password

Yes, No Prints the registered 
address list.

Print PCL Font List Yes, No Prints the list of PCL font samples. 

PSE Font List Yes, No Prints the list of PostScript font samples.

PPR Font List Yes, No Prints the list of IBM PPR font samples.

FX Font List Yes, No Prints the list of EPSON FX font samples.

Color Tuning 
Pattern

Yes, No Prints a color tuning pattern for adjusting 
gradation characteristics.

Color Profile List Yes, No Prints the list of colour profiles.
Appendix A - menu system > 87



PAPER SETUP

ITEM OPTION OPTION/DESCRIPTION

Tray 1 Paper Size A4/A5/A6/B5/
Letter/Legal13/
Legal13.5/Legal14/
Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Custom

Sets paper in Tray 1. 

Custom Width: 
105~210~216mm

Length: 
148~297~356mm

Enter paper width and length.

Media Type Plain/Letter Head/
Bond/Recycled/Card 
Stock/Rough/Glossy

Select the type of media loaded in this tray. 
This will help the MFP to adjust its internal 
operating parameters, such as engine 
speed and fusing temperature, to better 
accommodate the media to be fed. For 
example, letterhead may benefit from a 
slightly lower fusing temperature to ensure 
that its ink does not offset.

Media Weight Light/Medium Light/
Medium/Heavy/
Ultra Heavy1

Adjusts the MFP for the weight of paper 
stock loaded in this tray.

Tray 2 Paper Size A4/A5/B5/Letter/
Legal13/Legal13.5/
Legal14/Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Custom

Sets paper in Tray 2.

Custom Width: 
148~210~216mm

Length: 
210~297~356mm

Enter paper width and length.

Media Type Plain/Letter Head/
Bond/Recycled/Card 
Stock/Rough/Glossy

Select the type of media loaded in this tray. 
This will help the MFP to adjust its internal 
operating parameters, such as engine 
speed and fusing temperature, to better 
accommodate the media to be fed. For 
example, letterhead may benefit from a 
slightly lower fusing temperature to ensure 
that its ink does not offset.

Media Weight Light/Medium Light/
Medium/Heavy/
Ultra Heavy1

Adjusts the MFP for the weight of paper 
stock loaded in this tray.
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MP Tray Paper Size A4/A5/A6/B5/
Letter/Legal13/
Legal13.5/Legal14/
Executive/
16K(184x260mm)/
16K(195x270mm)/
16K(197x273mm)/
Custom/COM-9 
Envelope/COM-10 
Envelope/Monarch 
Envelope/DL 
Envelope/C5 
Envelope/Index 
Card

Select the size of paper to be fed from the 
multi purpose tray.

Custom Width: 
64~210~216mm

Length: 
127~297~1321mm

Enter paper width and length.

Media Type Plain/Letter Head/
Labels/Bond/
Recycled/Card 
Stock/Rough/Glossy

Select the type of media to be fed from the 
multi purpose tray so that the MFP can 
adjust its internal parameters to better 
accommodate the selected type of media.

Media Weight Light/Medium Light/
Medium/Heavy/
Ultra Heavy1/Ultra 
Heavy2

Select the media weight to be fed from the 
multi purpose tray.

Select Tray Faxa Tray 1: ON/OFF/ON(Prior) Fax: Set tray for 
received Fax.

Tray usage, priority 
given to trays set to 
ON(Prior), then ON. 
If tray is set to OFF, 
it will not be used.

Tray 2: ON/OFF/ON(Prior)

MP Tray: ON/OFF/ON(Prior)

Copy Tray 1: ON/OFF/ON(Prior) Copy: Set tray for 
copy jobs.

If Tray Selection is 
set to “Auto”: Tray 
usage, priority 
given to trays set to 
ON, then ON(Prior). 
If tray is set to OFF, 
it will not be used.

Tray 2: ON/OFF/ON(Prior)

MP Tray: ON/OFF/ON(Prior)

a. MC361 and MC561 only.

ITEM OPTION OPTION/DESCRIPTION
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ADDRESS BOOK

ITEM OPTION OPTION/DESCRIPTION

E-mail Address Select an address number.

Max. 100 entries.

Register Name user defined Enter a name for the e-mail address entry. 

Max. 16 characters.

E-mail Address user defined Enter the e-mail address. 

Max. 80 digits.

Group No. Add to a registered group.

Edit Edit settings. Refer to options above for 
details.

Delete Yes, No Delete entry.

Sort By Name Sort list of entries by name.

Sort By Number Sort list of entries by number.

E-mail Group Select a group number.

Max. 20 group entries.

Register Name user defined Enter a name for the e-mail group entry. 

Max. 16 characters.

Address No. Select and assign addresses from resultant 
list.

Max. 100 entries can be register to a group.

Edit Edit settings. Refer to options above for 
details.

Delete Yes, No Delete entry.

Sort By Name Sort list of entries by name.

Sort By Number Sort list of entries by number.
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PHONE BOOK

NOTE
MC361 and MC561 only.

ITEM OPTION OPTION/DESCRIPTION

Speed Dial Select a speed dial number.

Max. 100 speed dial entries.

Register Name user defined Enter a name for the speed dial entry. 

Max. 24 characters.

Fax Number user defined Enter the fax number for the speed dial 
entry. 

Max. 40 digits.

Group No. Add to a registered group.

Edit Edit settings. Refer to options above for 
details.

Delete Yes, No Delete entry.

Sort By Name Sort list of entries by name.

Sort By Number Sort list of entries by number.

Group No. Select a group number.

Max. 20 group entries.

Register Name user defined Enter a name for the group dial entry. 

Max. 16 characters.

Speed Dial Select and assign speed dial entries from 
resultant list.

Max. 100 entries can be register to a group.

Edit Edit settings. Refer to options above for 
details.

Delete Yes, No Delete entry.

Sort By Name Sort list of entries by name.

Sort By Number Sort list of entries by number.
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PROFILE

ITEM OPTION VALUE/DESCRIPTION

No. Select a profile number.

Register Profile Name user defined Sets a profile name. 

Max. 16 characters.

Protocol CIFS, FTP, HTTP Selects a protocol to use for storing files.

Target URL user defined Sets a server address and a directory to store the 
scanned data.

Max. 144 characters.

Port No. 1 ~ 445 ~65535 Sets a port number. 

PASV Mode OFF Sets whether to use the FTP Passive mode.

Display condition: Protocol set to FTP.

User Name user defined Sets a user name to use for logging onto the 
server.

Max. 32 characters.

Password user defined Sets a password to use when logging onto the 
server. 

Max. 32 characters.

CIFS Character 
Set

UTF-16, ASCII Sets a character set to use in CIFS.

Display condition: CIFS is set as a protocol.

Encode 
Communication

None Selects an encryption method for communication. 
Not available when using CIFS protocol. Choices 
vary depending on the protocol selected.

Scan Size A4, A5, A6, B5, 
Letter, Legal 13, 
Legal 13.5, Legal 14, 
Executive

Selects a scan size.

Image Settings Density -3 ~ 0 ~ +3 Sets the density of 
images.

Document Type Text, Text&Photo, 
Photo, Photo 
(Glossy)

Sets the image quality.

Background Removal OFF, 1, 2, 3, 4, 5, 6 Sets the default setup of 
the background removal.

Resolution 75dpi, 100dpi, 
150dpi, 200dpi, 
300dpi, 400dpi, 
600dpi

Selects a resolution.

Contrast -3 ~ 0 ~ +3 Sets the contrast.

Hue -3 ~ 0 ~ +3 Sets the red-green colour 
balance.

Saturation -3 ~ 0 ~ +3 Sets the colour saturation.

RGB -3 ~ 0 ~ +3

R:[0], G:[0], B:[0]

Sets the RGB contrast.
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Register
(cont.)

File Name user defined Sets a file name. Max. 64 characters.

The following options can be set as the default file 
name: 

#n: adding a serial number from 00000 to 99999

#d: adding the date of a file creation 
(yymmddhhmmss)

Greyscale OFF, ON Select ON to print in grayscale.

File Format Color PDF, TIFF, JPEG, 
XPS

Sets a file format for 
scanning.

Mono (Greyscale) PDF, TIFF, JPEG, 
XPS

Mono (Binary) PDF, TIFF, XPS

Encrypted PDF Not Encrypt Encryption disabled.

Encrypt Low, Medium, High Set encryption level.

Also enable/disable 
document open and 
permissions passwords.

Compression Rate Color High, Medium, Low Sets a compression rate 
for scanning.

Mono (Greyscale) High, Medium, Low

Mono (Binary) High, Medium, Raw

Edge Erase OFF Sets whether to erase the 
edge shadow created in 
the surrounding of 2-page 
spread documents.

ON Width:

5 mm

Sets an erasing width. 
Range: 5 to 50 mm.

Edit Edit profile settings. Refer to options above for 
details.

Delete Yes, No Delete profile.

Sort By
Name

Sort list of entries by name.

Sort By
Number

Sort list of entries by number.

ITEM OPTION VALUE/DESCRIPTION
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NETWORK SCAN DESTINATION

STORE DOCUMENT SETTINGS

ITEM OPTION OPTION/DESCRIPTION

No. Select a destination number.

Register Destination user defined Sets a destination name. 

Max. 16 characters.

Destination 
Address

user defined Sets a destination address. 

Max. 16 characters.

Port No. 9968 Sets a port number. 

Available range: 1 to 65535.

Edit Destination Edit destination name.

Destination Address Edit destination address.

Port No. Edit port no.

Delete Yes, No Deletes destination.

Sort By Name Sort list of entries by name.

Sort By Number Sort list of entries by number.

ITEM OPTION OPTION/DESCRIPTION

Store Fcode Bulletin 
Board

Over Write Stores documents in a bulletin box.

Delete Fcode Bulletin Board Deletes accumulated documents.

Received Documents

Print Fcode Box Prints accumulated documents.

Reserved Tx Doc.

Received Documents
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VIEW INFORMATION

SHUTDOWN

ITEM OPTION OPTION/DESCRIPTION

System 
Information

Serial No.

Asset No.

Lot No.

CU Version

PU Version

Scanner Version

Total Memory

Flash Memory

SD Memory Carda

a. MC561 only.

Displays system information

Network IPv4 Addressb

Subnet Maskb

Gateway Addressb

MAC Address

NIC Program Version

IPv6 Address (Local)c

IPv6 Address (Global)c

b. Appears only when the “TCP/IP” setting is “Enable” and the “IP Version” setting is “IPv4”.

c. Appears only when the “TCP/IP” setting is “Enable” and the “IP Version” setting is “IPv6”.

Displays network information

ITEM OPTION OPTION/DESCRIPTION

Shutdown Yes, No Select Yes to perform a controlled shutdown 
of the MFP, ensuring that all files on the 
internal hard disk are closed before power is 
turned off. Only power the MFP off when the 
display indicates that shutdown is complete.
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EASY SETUP

NOTE
The Easy Setup menu is blocked by the Admin password.

ITEM OPTION OPTION/DESCRIPTION

Date/Time Setting user defined Using the arrow keys, select your time zone, 
in relation to GMT, from the list. Press OK to 
continue.

Not Summer 
Time

Now Summer 
Time

Manual Day

Month

Year

Using the keypad 
and arrow keys, 
enter the correct 
date and time.

Hour 

Minute

Second

Server Set Address of SNTP 
Server (Primary)

user defined

Set SNTP Server 
(Secondary)

Fax Settinga Fax Number user defined Using the keypad and on screen options, 
enter the fax number of this machine.

Sender ID user defined Using the arrow keys and on screen 
keyboard, enter the sender ID.

Network Setting Manual

Auto

IP Address Specifies whether IP address allocation is 
automatic (DHCP) or manually assigned.

Display condition: TCP/IP protocol must be 
enabled.

Subnet Mask Current assigned subnet mask. 

To change, enter the address using the 
keypad. Press OK to register new address.

Display condition: TCP/IP protocol must be 
enabled.

Default Gateway Current assigned gateway address. 

To change, proceed as above.

Display condition: TCP/IP protocol must be 
enabled.

DNS Server 
(Primary)

Current assigned DNS server (primary). 

DNS Server 
(Secondary)

Current assigned DNS server (secondary). 

WINS Server 
(Primary)

Current assigned WINS server (primary). 

WINS Server 
(Secondary)

Current assigned WINS server (secondary). 
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ADMIN SETUP

E-mail Setting Set IP Address of 
Mail Server

user defined Enter the IP address of the mail server.

From user defined Enter the sender’s address

No Authentication Set the 
authentication 
method.SMTP Auth User Name

Password

POP Before SMTP Set Address of 
POP3 Server

User Name

Password

a. MC361 and MC561 only.

NOTE
The Admin Setup option is blocked by a password.

ITEM OPTION VALUE/DESCRIPTION

Copy Setup Default 
Settings

Scan size A4, A5, A6, B5, Letter, 
Legal 13, Legal 13.5, 
Legal 14, Executive

Allows you to select the 
document size.

Duplex Document -> 
Bind Position

OFF(Simplex), 
Simplex -> Duplex LE, 
Simplex -> Duplex SE, 
Duplex -> Duplex, 
Duplex LE -> Simplex, 
Duplex SE -> Simplex

Turns the duplex (2-
sided) function off or 
on.

Note: A6 duplex copy is 
not supported.

Zoom Auto, 100%, 
Zoom (25-400%), 
A4->A5(70%), 
Leg14->Let(78%), 
Leg13.5->Let(81%), 
Leg13->Let(84%), 
A4->B5(86%),
 A4->Let(94%), 
Let->A4(97%), 
Fit to page(98%), 
B5->A4(115%), 
A5->A4(141%)

Allows you to scale the 
copy using the presets 
values or by scaling in 
1% increments up to 
400% and down to 0 by 
entering the value using 
the keypad.

Sort ON, OFF ON prints 1 entire copy/
set of the multiple copy 
document at a time 
(e.g. pages 
1,2,3,1,2,3,1,2,3,…) 
OFF batch prints the 
multiple copy document 
page by page (e.g. 
pages 
1,1,1,2,2,2,3,3,3,…)

ITEM OPTION OPTION/DESCRIPTION
Appendix A - menu system > 97



Copy Setup 
(cont.)

Default 
Settings 
(cont.)

Image Settings

Density  : -3 ~ 0 ~ +3

Allows you to edit the 
image settings.

Document Type : Text, Text&Photo, 
Photo, Photo (Glossy)

Scan Resolution : Normal, Extra Fine

Background
Removal : OFF, 1, 2, 3, 4, 5, 6

Contrast : -3 ~ 0 ~ +3

Hue : -3 ~ 0 ~ +3

Saturation : -3 ~ 0 ~ +3

RGB : -3 ~ 0 ~ +3

R:0/G:0/B:0

Direction Portrait, Landscape Selects the default page 
orientation.

ID Card Copy ON, OFF Allows you to set ID 
card copying as the 
default copy mode.

Note: place the ID card 
5mm from the edge of 
the scanner flatbed.

Continue Scan ON, OFF Allows you to continue 
scanning more 
documents. Allows you 
to construct a single 
scan job from multiple 
individual sheets or 
originals.

Mixed Size ON, OFF Allows you to load 
originals of same width 
but different length in 
the ADF.

The following document 
sizes can be set 
concurrently; A3 and A4 
LEF, B4 and B5 LEF, 
A4SEF and A5 LEF.

When enabled, the tray 
setting is automatic, 
you cannot specify a 
tray manually.

Margin ON, OFF Allows you to change 
the document top and 
left margin areas. 

Input range: -25 to 
+25mm.

ITEM OPTION VALUE/DESCRIPTION
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Copy Setup 
(cont.)

Default 
Settings 
(cont.)

Edge Erase ON, OFF Allows you to block out 
the peripheral areas of 
the document where 
spurious shadows and 
borders may arise when 
copying with the 
document cover open 
(such as with books and 
magazines) or for other 
purposes. 

Input range: 5 to 
50mm.

Fax Setupa Default 
Settings

Resolution Normal, Fine, Extra-
Fine, Photo

Allows you to specify 
the type of images on 
the document. 

Density -3 ~ 0 ~ +3 Adjust density

Darker: Keep colour 
intensity and darker 
image.

Lighter: Reduce colour 
intensity and gives 
lighter image.

Scan Size A4, Letter, Legal 13, 
Legal 13.5, Legal 14

Allows you to select the 
paper size to match the 
document size.

Continue Scan ON, OFF Allows you to continue 
scanning more 
documents. Allows you 
to construct a single fax 
job from multiple 
individual sheets or 
originals.

TTI ON, OFF Prints the sender name 
on the header of the 
transmitted fax. By 
default, the name you 
specified in Sender ID is 
printed.

Transmit 
Confirmation Report

ON, OFF Select ON to print a fax 
confirmation after 
transmission.

Memory Tx ON, OFF Select OFF to enable 
real time transmission, 
i.e. fax transmission 
synchronisation with 
scanning.

ITEM OPTION VALUE/DESCRIPTION
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Fax Setupa 
(cont.)

Fcode Box

Register Confidential Box

Box Name

Sub-Address

Hold Time

I.D.Code

user defined

user defined

00 ~ 0 ~ 31

user defined

Confidential Box: 
received data cannot be 
printed without entering 
ID code (for secret 
documents).

You can also enter a 
Box Name, Password 
and specify the hold 
time for your secure 
box.

Range: 00 - 31

Bulletin Box

Box Name

Sub-Address

user defined

user defined

Bulletin Box: Enable to 
transmit/receive 
documents to/from 
Bulletin.

Edit Edit settings. Refer to options above for details.

Delete Yes, No Delete entry.

Security 
Function

ID Check Tx ON, OFF Check and match the 
last four digits of the 
destination fax numbers 
with those registered in 
the target. If ON, the 
MFP will send only when 
they match.

Broadcast 
Destination

ON, OFF Fax number 
confirmation screen 
displays before sending 
the fax.

Confirm Dial ON, OFF When ON, you will be 
asked to re-enter the 
destination fax number.

The fax will only be sent 
when the two numbers 
match.

Other 
Settings

Redial Tries 0 ~ 2 ~ 9 time(s) Set the number of redial 
attempts.

Range: 0 - 9 time(s)

Redial Interval 1 ~ 5 minute(s) Set the time between 
redial attempts.

Range: 1 - 5 minute(s)

Ring Response 1 Ring, 5 seconds, 
10 seconds, 15 seconds, 
20 seconds

Enter the number of 
rings required before 
receiving an incoming 
fax.

Dialling Pause 
Duration

0 ~ 2 ~ 10 second(s) Enter the pause 
duration required. 
Range: 0 - 10 second(s)

Rx Reduc. Rate Auto, 100% Select the Rx reduction 
rate.

Reduc. Margin 0 ~ 24 ~ 100 mm Select the reduction 
margin.

Range: 0 - 100 mm
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Fax Setupa 
(cont.)

Other 
Settings 
(cont.)

ECM Mode ON, OFF Error correction mode 
(ECM) automatically 
detects and corrects 
errors in the fax 
transmission process 
that are sometimes 
caused by telephone 
line noise.

Prefix user defined Enter the require 
dialling prefix (if you are 
connected via a PBX 
then you need to enter 
a prefix to obtain an 
outside line connection).

Received Time 
Stamp

ON, OFF Set to ON if you want 
the time stamp printed 
on incoming faxes.

Print Check Message ON, OFF If enabled, when a 
transmission error 
occurs the error content 
is reported.

Fax Setting Service Bit ON, OFF

Country Code International Select the country in 
which the MFP is 
situated.

H/Modem Rate (For 
Tx)

33.6 Kbps, 28.8 Kbps, 
14.4 Kbps, 9.6 Kbps, 
48. Kbps

Specify modem rate.

Note: If you are using 
an IP phone line and fax 
Tx/Rx fails, change the 
modem rate to 
14.4kbps or less.

H/Modem Rate (For 
Rx)

33.6 Kbps, 28.8 Kbps, 
14.4 Kbps, 9.6 Kbps, 
48. Kbps

PBX Line ON, OFF

Forwarding Setting ON, OFF

TAD Mode Type 1, Type 2, Type 3 Specify TAD mode type.

Tel Priority Mode ON, OFF

CNG Detection ON, OFF

T/F Timer 
Programming

20 seconds, 
35 seconds

Soft Ringer Volume OFF, Low, Middle, High Select volume level.

Remote Receive 
Number

OFF, 000, 111, 222, 
333, 444, 555, 666, 
777, 888, 999
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Internet Fax 
Setup

Default 
Settings

Scan Size A4, Letter, Legal 13, 
Legal 13.5, Legal 14

Allows you to select the 
paper size to match the 
document size.

Density -3 ~ 0 ~ +3 Adjust density

Darker: Keep colour 
intensity and darker 
image.

Lighter: Reduce colour 
intensity and gives 
lighter image.

Resolution Normal, Fine, Extra-
Fine, Photo

Allows you to specify 
the type of images on 
the document. 

Background 
Removal

OFF, 1, 2, 3, 4, 5, 6 Allows you to block out 
the colour background 
of the image (assuming 
document has a colour 
background) - such that 
the background colour 
is not printed.

Continue Scan ON, OFF Allows you to continue 
scanning more 
documents. Allows you 
to construct a single fax 
job from multiple 
individual sheets or 
originals.

Compression Rate High, Medium, Low Select the appropriate 
compression level.

Scanner 
Setup

Default 
Settings

Scan Size A4, A5, A6, B5, Letter, 
Legal 13, Legal 13.5, 
Legal 14, Executive

Allows you to select the 
scan size.

Image Settings

Density  : -3 ~ 0 ~ +3

Allows you to adjust 
image settings.

Document Type : Text, Text&Photo, 
Photo, Photo (Glossy)

Background
Removal : OFF, 1, 2, 3, 4, 5, 6

Resolution : 75dpi, 100dpi, 150dpi, 
200dpi, 300dpi, 400dpi, 
600dpi

Contrast : -3 ~ 0 ~ +3

Hue : -3 ~ 0 ~ +3

Saturation : -3 ~ 0 ~ +3

RGB : -3 ~ 0 ~ +3

R:0/G:0/B:0

Continue Scan ON, OFF Allows you to continue 
scanning more 
documents. Allows you 
to construct a single 
scan job from multiple 
individual sheets or 
originals.

ITEM OPTION VALUE/DESCRIPTION
Appendix A - menu system > 102



Scanner 
Setup (cont.)

Default 
Settings 
(cont.)

Greyscale ON, OFF Select ON to print in 
grayscale.

File Format

Color:

Greyscale:

Mono:

PDF, TIFF, JPEG, XPS

PDF, TIFF, JPEG, XPS

PDF, TIFF, XPS

Select the appropriate 
file format.

Encrypted PDF 
Setting

Document Open
Password:

Permissions
Password:

Display Default
Password:

user defined

user defined

Disable, Enable

Set the encryption 
passwords and display 
option.

Compression Rate

Color:

Greyscale:

Mono:

High, Medium, Low

High, Medium, Low

High, Medium, Raw

Select the appropriate 
compression level.

Edge Erase ON, OFF Input range: 5 to 
50mm.
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Scanner 
Setup (cont.)

E-mail Setup

File Name user defined

Template Edit Subject

Edit Body

Select template from list

From / Reply
To

From:

Address Book

Select e-mail address 
from the address book.

Direct Input Enter e-mail address 
using the on-screen 
keyboard.

LDAP Simple Search Use the on-screen 
keyboard to enter a 
search value.

Advanced Search

Search Method

User Name

E-mail Address

Use Advanced Search to 
search the LDAP 
address book by user 
name and/or 
e-mail address.

Reply To: user defined

Broadcast
Destination

ON, OFF

MDN
Response

ON, OFF

A/R Full Print ON, OFF

MCF Report ON, OFF Select ON to print a fax 
confirmation after 
transmission.

Timeout of
MCF Report

OFF, 5 minutes, 
15 minutes, 
30 minutes, 90 minutes, 
150 minutes

Print Check
Message

ON, OFF If enabled, when a 
transmission error 
occurs the error content 
is reported.

USB Memory 
Setup

File Name user defined Max. 64 characters.

#n:Assigns a 
consecutive number as 
the file name.

#d:Assigns a created 
date and time 
(YYMMDDHHMMSS 
format) as the file 
name.

TWAIN Setup Network TWAIN ON, OFF

Port No. 1 ~ 9967 ~ 65535 Range: 1 - 65535

PC Scan Mode Simple Scan Mode, 
Secure Scan Mode

Timeout Setting 1 ~ 5 ~ 30 minute(s) Range: 1 - 30 minute(s)

Scanner 
Calibration

Execute Yes, No
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Print From 
USB Memory 
Setup

Default 
Settings

Paper Feed Tray 1(A4), 
Tray 2(A4), MP Tray(A4)

Selects the default tray 
for paper feed, Tray 1 
(upper), Tray 2 (lower, 
if installed) or MP Tray 
(multi purpose tray).

Copies 1 - 999 Enter the number of 
copies of a document to 
be printed.

Duplex ON, OFF Switches the Duplex (2 
sided) function ON/OFF.

Binding Long Edge Bind, 
Short Edge Bind

Display condition: 
duplex setting is 
enabled.

Fit ON, OFF Sets the printing mode 
that can fit print data in 
the printable area.

Print Setup Print Menu Tray Configuration

Paper Feed: Tray 1, Tray 2, MP Tray

Adjust tray 
configuration settings.

Auto Tray Switch: ON, OFF

Tray Sequence: Down, Up, Paper Feed 
Tray

MP Tray Usage: When Mismatching, 
Do Not Use

Media Check: Enable, Disable

Print Setup

Copies: 1 - 999

Adjust print setup.

Duplex: ON, OFF

Binding: Long Edge Bind, Short 
Edge Bind

Resolution: 600x1200dpi, 
600dpi M-LEVEL

Toner Save Mode: ON, OFF

Mono-Print Speed: Auto, Color Print Speed, 
Normal print Speed

Orientation: Portrait, Landscape

Lines Per Page: 5 ~ 64 ~ 128 Line(s)

Edit Size: Cassette Size, A4, A5, 
A6, B5, Letter, Legal 13, 
Legal 13.5, Legal 14, 
Executive, 
16K(184x260mm), 
16K(195x270mm), 
16K(197x280mm), 
Custom, COM-9 
Envelope, COM-10 
Envelope, Monarch 
Envelope, DL Envelope, 
C5 Envelope, Index Card

Width: 64 ~ 210 ~ 216 mm

Length: 127 ~ 297 ~ 1321 mm
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Print Setup 
(cont.)

Print Menu 
(cont.)

Printer Adjust

Manual Timout: Disable, 30 seconds, 
60 seconds

Adjust general printer 
settings.

Wait Timeout: Disable, 5 seconds, 10 
seconds, 20 seconds, 30 
seconds, 40 seconds, 
50 seconds, 60 seconds, 
90 seconds, 120 
seconds, 150 seconds, 
180 seconds, 210 
seconds, 240 seconds, 
270 seconds, 300 
seconds

Print Mode Without
Color Toner: Alarm, Cancel

Jam Recovery: Enable, Disable

Paper Black Setting: -2 ~ 0 ~ +2

Paper Color Setting: -2 ~ 0 ~ +2

SMR Setting: -3 ~ 0 ~ +3

BG Setting: -3 ~ 0 ~ +3

Print Position Adjust

Front X Adjust:

Front Y Adjust:

Back X Adjust:

Back Y Adjust:

0.00 mm

0.00 mm

0.00 mm

0.00 mm

Range: -2.00 to +2.00 
mm

Drum Cleaning ON, OFF Set to produce idling of 
a drum before printing 
in order to reduce 
horizontal white lines. 
This shortens image 
drum life.

Hex Dump ON, OFF Prints out the data 
received from the host 
PC in hexidecimal code.

Color Menu Density Control Auto, Manual If set to Auto, image 
density will be 
automatically adjusted 
at power on, when a 
new image drum or 
toner cartridge is 
installed, and at 
intervals of 100, 300 
and 500 drum counts. If 
a 500 drum count 
interval occurs during a 
print job it will occur at 
the end of that job, and 
will take up to 55 
seconds. If set to 
manual, this adjustment 
will only be performed 
when initiated by the 
next menu item.
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Print Setup 
(cont.)

Color Menu 
(cont.)

Adjust Density Execute Selecting this will 
perform the auto 
density set up 
immediately.

Color Tuning/Print 
Pattern

Execute Selecting this item 
prints the colour tuning 
pattern to help you 
adjust the colour 
balance.

Cyan Highlight -3 ~ 0 ~ +3 Adjusts image density 
for each colour 
component (cyan, 
magenta, yellow and 
black). Normal setting is 
0.

Cyan Mid-Tone -3 ~ 0 ~ +3

Cyan Dark -3 ~ 0 ~ +3

Magenta Highlight -3 ~ 0 ~ +3

Magenta Mid-Tone -3 ~ 0 ~ +3

Magenta Dark -3 ~ 0 ~ +3

Yellow Highlight -3 ~ 0 ~ +3

Yellow Mid-Tone -3 ~ 0 ~ +3

Yellow Dark -3 ~ 0 ~ +3

Black Highlight -3 ~ 0 ~ +3

Black Mid-Tone -3 ~ 0 ~ +3

Black Dark -3 ~ 0 ~ +3

Cyan Darkness -3 ~ 0 ~ +3 Adjusts darkness of 
each colour (cyan, 
magenta, yellow and 
black). Normal setting is 
0.

Magenta Darkness -3 ~ 0 ~ +3

Yellow Darkness -3 ~ 0 ~ +3

Black Darkness -3 ~ 0 ~ +3

Adjust Registration Execute Performs automatic 
colour registration 
adjustment. Normally 
this is done on power on 
and when the top cover 
is opened and then 
closed. This process 
accurately aligns the 
cyan, magenta and 
yellow images to the 
black image.

Cyan Reg Fine Adj -3 ~ 0 ~ +3 Performs fine 
adjustment of image 
timing in relation to the 
black image component.

Magenta Reg Fine 
Adj

-3 ~ 0 ~ +3

Yellow Reg Fine Adj -3 ~ 0 ~ +3

Ink Simulation OFF, SWOP, 
EUROSCALE, JAPAN

Selects from a range of 
industry standard colour 
swatches.
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Print Setup 
(cont.)

Color Menu 
(cont.)

UCR Low, Medium, High Selects the limitation of 
the toner layer 
thickness.

If paper curl occurs in 
dark printing, selecting 
Medium or Low 
sometimes helps reduce 
curl.

CMY100% Density Enable, Disable When enabled, black 
areas are produced 
using 100% C, M, and Y 
instead of black. This 
results in a glossier 
finish.

CMYK Conversion ON, OFF Setting to OFF will 
simplify the conversion 
process of CMYK data, 
which will reduce 
process time.

This setting is ignored 
when Ink Simulation 
function is used.

System 
Configuration 
Menu

Personality Auto Emulation, PCL, 
IBM PPR, EPSON FX, 
PS3 Emulation

This item selects which 
industry standard 
emulation your MFP 
should use. When set to 
Auto, incoming data is 
examined and the 
correct emulation is 
automatically selected 
each time a print job is 
received.

Alarm Release Manual, Auto When Manual, non-
critical warnings, such 
as requests for a 
different paper size, can 
be cleared by pressing 
the RESET button. 
When set to Auto, they 
are cleared when the 
print job resumes.

Auto Continue ON, OFF Determines whether or 
not the MFP will 
automatically recover 
from a memory 
overflow condition.

Error Report ON, OFF If ON, the MFP will print 
error details when a 
PostScript emulation 
error occurs.
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Print Setup 
(cont.)

PCL Setup Font Source Resident, Resident2 Specifies the location of 
the PCL default font. 
Normally this will be 
internal unless 
additional fonts are 
installed in the 
expansion POM slot or 
additional fonts have 
been downloaded to 
RAM as permanent 
fonts.

Font No. I0 ~ I90 Sets the PCL font 
number.

Font Pitch 0.44~10.00~99.99 CPI Sets the width of the 
PCL default font.

Font Height 4.00~12.00~999.75 
point(s)

Sets the height of the 
PCL default font.

Symbol Set PC-8 PCL symbol set. If the 
font source and number 
are changed to one 
which does not support 
the selected symbol set, 
this must be changed to 
an available symbol set 
for that font.

A4 Print Width 78 Column, 80 Column Sets the number of 
columns subject to Auto 
LF with A4 paper in PCL. 
This is the value when 
Auto CR/LF Mode is set 
to OFF with the 10CPI 
character.

White Page Skip ON, OFF Selects whether blank 
pages are printed or 
not.

CR Function CR, CR+LF Selects whether a 
received carriage return 
character (0Dh) also 
causes a line feed.

LF Function LF, CR+LF Selects whether a 
received line feed 
character (0Ah) also 
causes a carriage 
return.

Print Margin Normal, 
1/5 inch, 1/6 inch

Sets the non-printable 
page area. Normal is 
PCL compatible.

True Black ON, OFF Selects whether black 
image data is printed 
using black toner (True 
Black ON) or 100% 
CMY. (Valid in PCL 
emulation mode only.)
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Print Setup 
(cont.)

PCL Setup 
(cont.)

Pen Width Adjust ON, OFF The thinnest line width 
in PCL, a 1-dot line, 
may look broken.

ON: when the thinnest 
line width is specified, 
line width is emphasized 
to look wider.

OFF: the line appears 
as specified.

Tray ID#

Tray 2 :

MP Tray :

1 ~ 5 ~ 59

1 ~ 4 ~ 59

Sets the number to 
specify Tray 2 and MP 
Tray for the paper feed 
destination command in 
PCL5e emulation.

PS Setup L1 Tray Type 1, Type 2 Switches between 
Postscript types.

SIDM Setup SIDM Manual ID# 0 ~ 2 ~ 9 Set up Pn specified in 
MANUAL by MANUAL-1 
ID No.FX/PPR Emu in 
CSF control command 
(ESC EM Pn).

SIDM Manual2 ID# 0 ~ 3 ~ 9 Set up Pn specified 
MANUAL by MANUAL-2 
ID No.FX/PPR Emu in 
CSF control 
command(ESC EM Pn).

SIDM MP Tray ID# 0 ~ 4 ~ 9 Set up Pn specified 
TRAYO(MP Tray) by MP 
Tray ID No.FX/PPR Emu 
in CSF control 
command(ESC EM Pn).

SIDM Tray1 ID# 0 ~ 1 ~ 9 Set up Pn specified 
TRAY 1by Tray 1 ID 
No.FX/PPR Emu in CSF 
control command(ESC 
EM Pn).

SIDM Tray2 ID# 0 ~ 5 ~ 9 Set up Pn specified 
TRAY 2 by Tray 2 ID 
No.FX/PPR Emu in CSF 
control command (ESC 
EM Pn).

IBM PPR 
Setup

Character Pitch 10 CPI, 12 CPI, 17 CPI, 
20 CPI, Proportional

Specifies character pitch 
in IBM PPR emulation.

Font Condense 12CPI to 20CPI, 
12CPI to 12CPI

Specifies 12CPI pitch for 
Condense Mode.

Character Set SET-1, SET-2 Specifies a character 
set.

Symbol Set IBM-437 Specifies a symbol set.

Letter O Style Enable, Disable Specifies the style that 
replaces 9BH with letter 
o and 9DH with a zero

Zero Character Normal, Slashed Sets the zero to be 
slashed or unslashed.

Line Pitch 6 LPI, 8 LPI Specifies the line 
spacing.
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Print Setup 
(cont.)

IBM PPR 
Setup (cont.)

White Page Skip ON, OFF Selects whether blank 
pages are printed or 
not.

CR Function CR, CR+LF Selects whether a 
received carriage return 
character (0Dh) also 
causes a line feed.

LF Function LF, LF+CR Selects whether a 
received line feed 
character (0Ah) also 
causes a carriage 
return.

Line Length 80 Column, 
136 Column

Specifies the number of 
characters per line.

Form Length 11 inch, 11.7 inch, 
12 inch

Specifies the length of 
paper.

TOF Position 0.0 ~ 1.0 inch Specifies the distance of 
print from the top edge 
of the paper.

Left Margin 0.0 ~ 1.0 inch Specifies the distance of 
print from the left hand 
edge of the paper.

Fit To Letter Enable, Disable Sets the printing mode 
that can fit print data, 
equivalent to 11 inches 
(66 lines), in the 
LETTER-size printable 
area.

Text Height Same, Diff Sets the height of a 
character.

SAME: Regardless of 
CPI, same height

DIFF: As CPI, character 
heights vary.

EPSON FX 
Setup

Character Pitch 10 CPI, 12 CPI, 17 CPI, 
20 CPI, Proportional

Specifies character pitch 
in this emulation.

Character Set SET-1, SET-2 Specifies a character 
set.

Symbol Set IBM-437 Specifies a symbol set.

Letter O Style Enable, Disable Specifies the style that 
replaces 9BH with letter 
o and 9DH with a zero

Zero Character Normal, Slashed Sets the zero to be 
slashed or unslashed.

Line Pitch 6 LPI, 8 LPI Specifies the line 
spacing.

White Page Skip ON, OFF Selects whether blank 
pages are printed or 
not.

CR Function CR, CR+LF Selects whether a 
received carriage return 
character (0Dh) also 
causes a line feed.
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Print Setup 
(cont.)

EPSON FX 
Setup (cont.)

Line Length 80 Column, 
136 Column

Specifies the number of 
characters per line.

Form Length 11.7 inch, 12 inch Specifies the length of 
paper.

TOF Position 0.0 ~ 1.0 inch Specifies the distance of 
print from the top edge 
of the paper.

Left Margin 0.0 ~ 1.0 inch Specifies the distance of 
print from the left hand 
edge of the paper.

Fit To Letter Enable, Disable Sets the printing mode 
that can fit print data, 
equivalent to 11 inches 
(66 lines), in the 
LETTER-size printable 
area.

Text Height Same, Diff Sets the height of a 
character.

SAME: Regardless of 
CPI, same height

DIFF: As CPI, character 
heights vary.

Network 
Menu

Network 
Setup

TCP/IP Enable, Disable Enables or disables this 
network protocol.

IP Version IPv4, IPv4+IPv6 Set up the IP version.

Display condition: TCP/
IP protocol must be 
enabled.

NetBEUI Enable, Disable Enables or disables this 
network protocol.

NetBIOS Over TCP Enable, Disable Enables or disables this 
network protocol.

Display condition: TCP/
IP protocol must be 
enabled.

NetWare Enable, Disable Enables or disables this 
network protocol.

EtherTalk Enable, Disable Enables or disables this 
network protocol.

Frame Type Auto, 802.2, 802.3, 
ETHERNET II, SNAP

Selects the Ethernet 
MAC layer frame type.

Display condition: 
Netware must be 
enabled.

IP Address Set Auto, Manual Specifies whether IP 
address allocation is 
automatic (DHCP) or 
manually assigned.

Display condition: TCP/
IP protocol must be 
enabled.
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Network 
Menu (cont.)

Network 
Setup (cont.)

IPv4 Address xxx.xxx.xxx.xxx Current assigned IP 
address. 
To change, enter the 
address using the 
numerical keypad. Press 
Enter to register new 
address.

Display condition: TCP/
IP protocol must be 
enabled.

Subnet Mask xxx.xxx.xxx.xxx Current assigned subnet 
mask. To change, 
proceed as above.

Display condition: TCP/
IP protocol must be 
enabled.

Gateway Address xxx.xxx.xxx.xxx Current assigned 
gateway address. To 
change, proceed as 
above.

Display condition: TCP/
IP protocol must be 
enabled.

DNS Server 
(Primary)

0.0.0.0 The IP address of your 
DNS server (primary).

DNS Server 
(Secondary)

0.0.0.0 The IP address of your 
DNS server 
(secondary).

WINS Server 
(Primary)

0.0.0.0 The IP address of your 
WINS server (primary).

WINS Server 
(Secondary)

0.0.0.0 The IP address of your 
WINS server 
(secondary).

Web Enable, Disable Enables or disables web 
config. facility.

Display condition: TCP/
IP protocol must be 
enabled.

Telnet Enable, Disable Enables or disables 
Telnet config. facility.

Display condition: TCP/
IP protocol must be 
enabled.

FTP Enable, Disable Enables or disables 
communication via FTP.

Display condition: TCP/
IP protocol must be 
enabled.

IPSec Enable, Disable Enable via the web page 
or Configuration Tool.

SNMP Enable, Disable Enables or disables 
SNMP of FTP (TCP/IP or 
NetWare).

Display condition: TCP/
IP protocol must be 
enabled.
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Network 
Menu (cont.)

Network 
Setup (cont.)

Network Scale Normal, Small Normal: Can work 
effectively even when 
connected to a HUB that 
has a spanning tree 
feature. However, 
printer start up time 
gets longer when 
computers are 
connected to two or 
three small LANs.

Small: Computers can 
cover from two or three 
small LANs to a large 
LAN, but it may not 
work effectively when it 
is connected to a HUB 
with a spanning tree 
feature.

HUB Link Setting Auto Negotiate, 
100BASE-TX FULL, 
100BASE-TX HALF, 
10BASE-T FULL, 
10BASE-T HALF

Sets the hub linking 
method.

Network PS-Protocol ASCII, RAW Select PostScript data 
format for the network 
port.

Factory Defaults Execute Select Yes to reload the 
settings present when 
the unit was setup by 
the manufacturer.

Mail Server 
Setup

SMTP Server user defined Set the host name for 
the SMTP server.

SMTP Port 1 ~ 25 ~ 65535 Set the port number. 

SMTP Encryption None, SMTPS, 
STARTTLS

Select encryption 
method.

POP3 Server user defined Set the IP address or 
host name for the POP3 
server.

POP3 Port 1 ~ 110 ~ 65535 Set the port number.

POP Encryption None, POP3S, 
STARTTLS

Select encryption 
method.

Authentication 
Method

None, SMTP, POP Set the authentication 
method.

SMTP User ID user defined Set a user ID for the 
SMTP server.

SMTP Password user defined Set a password for the 
SMTP server.

POP User ID user defined Set a user ID for the 
POP3 server.

POP Password user defined Set a password for the 
POP3 server.
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Network 
Menu (cont.)

LDAP Server 
Setting

Server Setting

LDAP Server:

Port No.:

Timeout:

Max. Entries:

Search Root:

user defined

1 ~ 389 ~ 65535

10 ~ 30 ~ 120second(s)

5 - 100 Entries

user defined

Edit the LDAP server 
settings.

Attribute

Name1:

Name2:

Name3:

E-mail Address:

Additional Filter:

cn

sn

givenName

mail

user defined

Edit the LDAP search 
attribute if required.

Authentication

Method: Anonymous, Simple, 
Digest-MD5, Secure 
Protocol

Set the authentication 
method for LDAP.

User ID: user defined Set a user ID and 
password for the LDAP 
server.

Displays when 
authentication method 
is set.

Password: user defined

Encryption None, LDAPS, 
STARTTLS

Set the encryption 
method.

Secure 
Protocol 
Server 
Setting

Domain user defined Domain must be 
registered in the DNS 
server.

Management Default Mode Copy, Scan, Print, Fax* * MC361 & MC561 only.

Operation 
Clear

Operation Timeout After 1 ~3~ 10 minutes

Clear After Job ON, OFF

Sound 
Control

Key Touch Tone 
Volume

OFF, Low, Middle, High Select key touch volume 
level.

Fax Buzzer Volume OFF, Low, Middle, High Select volume level.

Local 
Interface

USB Menu

Soft Reset:

Speed:

USB PS_Protocol:

Offline Receive:

Serial Number:

Enable, Disable

480Mbps, 12 Mbps

ASCII, RAW

Enable, Disable

Enable, Disable

Default settings listed, 
these can be changed if 
required.

System 
Setup

Access Control PIN, User/Password, 
Disable

Enable access control to 
restrict usage to 
authorised user only.

Unit Of Measure Inch, Millimeter Select unit of measure.

Date Format mm/dd/yyyy, 
dd/mm/yyyy, 
yyyy/mm/dd

Select desired date 
format.

Allow All Reports To 
Print

Enable, Disable Enable/disable report 
printing.
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Management 
(cont.)

System 
Setup (cont.)

Near Life LED Enable, Disable Enable/disable near life 
LED.

Status In Near Life Enable, Disable Enable: Display a near-
life warning.

Disable: Do not display 
a near-life warning.

Address Information 
Lock Time Out

1 ~ 3 ~ 10 minute(s) Enter time-out duration.

USB Memory 
Interface

Enable, Disable Select disable to turn off 
scan to USB function.

Panel Contrast -10 ~ 0 ~ +10 Adjust the LCD panel 
contrast.

Power Save Power Save Time 1 minute, 2 minutes, 
3 minutes, 4 minutes, 
5 minutes, 10 minutes, 
15 minutes, 
30 minutes, 
60 minutes, 
120 minutes

Select desired time 
interval before machine 
enters power save 
mode.

Sleep Time 1 minute, 2 minutes, 
3 minutes, 4 minutes, 
5 minutes, 10 minutes, 
15 minutes, 
30 minutes, 
60 minutes, 
120 minutes

Select desired time 
interval before machine 
enters sleep mode.

Silent Mode ON, OFF Enable/disable silent 
mode.

ECO Mode ON, OFF When ON, if the 
machine is in power 
save mode and you 
send a small print job (1 
or 2 pages), the 
machine will print the 
job without warming the 
fuser to the “normal” 
operating temperature 
beforehand.

Memory 
Setup

Receive Buffer Size Auto, 0.5 MB, 1 MB, 
2 MB, 4 MB, 8 MB

Specify the size of the 
buffer you want to use 
to receive data.

Resource Save Auto, OFF, 0.5 MB, 
1 MB, 2 MB, 4 MB, 8 MB

Specify the size of the 
buffer you want to use 
for resource saving.

Storage 
Maintenance 
Setup

Check File System Execute Making changes will 
automatically restart 
the system.

Erase SD Memory 
Card

Execute Deletion of all data 
stored in the SD Card. 
Data cannot be 
recovered.

Initial Lock Enable, Disable Enable/disable initial 
lock.
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Management 
(cont.)

Encryption 
Setup

Job Limitation Disable, 
Encrypted Job Only

Enable/disable 
limitation setting.

Language 
Maint Setup

Initialize Execute Making changes will 
automatically restart 
the system. 

Admin 
Password

New Password user defined Enter new password.

Retype your password 
when prompted to 
verify.

Note: password must 
be six characters or 
more.

Enter Password 
(Verify)

user defined

Reset Settings Execute Continuing will 
automatically restart 
the system.

Job Log 
Setup

Save Job Log Enable, Disable

Print 
Statistics

Supplies Report Enable, Disable Indication of frequency 
of consumable 
exchange/non indication 
is set.

Reset Main Counter Execute Zeros the counter.

User Install Time Setup Auto Setup

SNTP Server
(Primary):

SNTP Server
(Secondary):

user defined

user defined

Set todays date and 
time automatically.

Manual

Date:

Time:

user defined

user defined

Enter todays date and 
time using the keypad. 
Use the arrow keys to 
move between digits.

Set Daylight Saving ON, OFF Enable/disable daylight 
saving setting.

Time Zone 00:00 Range: -12:00 to 
+12:00 minutes in 15 
minute increments.

Power Save Power Save Enable ON, OFF Enable/disable power 
save mode.

Sleep ON, OFF Enable/disable sleep 
mode.

High Humid Mode ON, OFF If moistened paper is 
curled significantly after 
printing, change the 
setting to ON. Note: 
Moistened paper means 
paper that has been left 
in a high-humidity 
environment.

MF(Tone)/DP(Pulse) Tone, Pulse Select the appropriate 
dialling method for the 
region you are in.
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User Install 
(cont.)

Reception Mode Fax Ready Mode, 
Tel/Fax Ready Mode, 
Ans/Fax Ready Mode, 
Tel Ready Mode, DRD

Specify the reception 
mode.

DRD Type Type 1, Type 2, Type 3, 
Type 4

Allows the machine to 
detect a distinctive ring 
if it has been enabled on 
the phone line.

Dial Tone Detection ON, OFF Enable/disable dial tone 
detection.

Busy Tone Detection ON, OFF Enable/disable busy 
tone detection.

TTI Register/
Edit

TTI 1:

TTI 2:

TTI 3:

user defined Register/Edit transmit 
terminal identification 
(TTI) settings.

Standard TTI TTI 1, TTI 2, TTI 3 Select default TTI from 
the registered list.

TTI Number user defined Enter your fax number.

TTI Calendar Type yyyy/mm/dd, 
mm/dd/yyyy, 
dd/mm/yyyy

Specify the TTI calendar 
date format.

Super G3 ON, OFF OFF=G3, ON=SuperG3

Erase Privacy Data Execute Continuing will delete all 
settings and registered 
data.

a. MC361 and MC561 only.
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